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1 Introduction

1.1 System Description

SourceLink software has been designed to work with the Universal Encoder II to provide
a complete solution for the demands of the 21* century Land Seismic acquisition system.

The system provides a real time Source Driven acquisition for all types of Land Source
Seismic Source devices. Multiple source types can be used on the same prospect, the system allows
seamless integration between the multiple sources. The source positions from the multiple sources
can be simultaneously viewed and controlled.

The VHF radios use a TDMA type communication scheme for all radio telemetry. This
technology allows multiple groups to operate on the same frequency without any radio collisions.
It assists crews to maximize production and eliminate unnecessary “dead time” between VP’s.

The basic System consists of the following:

e  Universal Encoder Il — (UE2) — The UE2 provides the interface between the
SourceLink Software and the VHF radios. Multiple reference signals are available
for simultaneously acquiring multiple fleets of vibrators.

e VHF radio — standard Digital or analog VHF radios can be used with the system
to provide excellent telemetry over the large area. Because of the GPS timing
synchronization of the system, additional radio repeaters can be added to cover the
entire prospect without changing the basic timing of the system.

e Central Computer with the SourceLink software
GPS timing module

1.2 Computer Requirements

The SourceLink Software requires a high resolution screen to operate. Multiple High
resolution screens are recommended for the SourceLink/UE2 system.

Minimum Computer requirements:

16.4" Screen or larger

Intel Core 17 17-2630QM 2 GHz or equivalent
1920 x 1080 Full HD Display

4 GB RAM

Genuine Windows 7 Professional

Seismic Source Company 6
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SourceLink™ software

+ Specifically designed to maximize production with Continuous Recording Systems like iSeis
Sigma, OYO GSR, Fairfield Node, Sercel Unite and all other systems.

+ Uses GPS time synchronization - synchronizes sources with the Recording systems clock -

no sample skew.

+ System provides Simultaneous Control and QC of all sources on the project:

* Multiple Vibrator Groups

* Multiple Dynamite Groups
* Multiple AND Groups

» Air Gun boats

+ Easy to use Graphical Map Interface:

* Provides complete control

» Automatically finds Group COG
» Selects near flag

* Fires the shot

* Real-Time Group Status:
» Distance to selected flag
» Sweep/Ready status
* EP Number of VP
» Error conditions

+ Supports all Simultaneous Vibroseis Methods:

» Slip Sweep (Shell)

* HFVS (ExxonMobil)

+ ZenSeis (ConocoPhillips)

+ |SS and DSSS (BP)

+ Combination of above methods

Hmer Siawca

5034/ 1026

Oetince indesr 0ane P Lo &
[
I )

Feady

Semey Rarrier

2
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Real-Time QC:

* Real-Time Graphical QC : I I I i
of Source performance - :
« Classical Display of i . . .
Vibrator performance: i J ] I J
* Correlation Phase o B 2
+ Correlation Force : . [
+ Distortion : : ' | | A
+ Vibrator Error Limits ’ : L
B e e o
LS. - | Real-Time Statistics:
i . -+ | Line Graph shows Vibrator Performance
ot N LA s e B for last 100 sweeps
D e e e L EBS}' to see any Vibrator prob!ems
* i s

» PSS Status can also be displayed
graphically on MAP

« Out of specification shots and missing
shots are easily identified

» For Dynamite operation different Uphole
times are shown in different colors to
show variance of Uphole time graphically

| 1;._! 1l | -1 f

» Statistical Analysis of PSS data

» Summarizes Vibrator performance

* Shows number or errors and percent

» Each Vibrator statistics are shown
for easy comparison
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2 SourceLink UE2 Setup

2.1 SourceLink UE2 Setup

I modsEsccde

96*" ]
-
= w:sa

2.1.1 Cable Connections

Connect UE2 to computer with patch cable provided
e Connect 11-18 VDC supply to UE2 cable
e Note: The UE2’s Battery LED’s will show the status of the battery voltage,
e Green Flash — battery voltage is above 12 volts
e Amber Flash — battery voltage is between 10and 12 volts
¢ Red Flash - battery voltage is below 10 volts
Connect the Radio cable to the UE2
e Connect GPS unit to the UE2
e Connect the AUX outputs of the UE2 to an external recorder if required

2.1.2 Computer Setup

e Connect the Computer to UE2 Ethernet port, make sure the Computer LAN Network is set to
static IP address in 10.x.x.x network (like 10.0.0.101, make sure the Computer IP address is
different from TDMA Encoder’s IP address). If the Computer needs to be set in different
network for any other reason, make sure to configure UE-2 to that IP network using DAQflash
software. Please refer Section 3 of this manual for Ethernet setup information.

¢ Software Installation: Install SourceLink software.

Seismic Source Company 9
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2.1.3 UE2 GPS Setup
The GPS unit used with the UE2 requires an accurate pulse per second (PPS) and RS232

serial data. The GGA and GSA NMEA serial strings are required for proper operation. The UE2
is setup to receive the data a 19.2 K baud.

The following diagram shows basic configuration:

S5C -TDMA Source Controllers with Autonomous Recording Systems

=
= FQ R i

55C
TDMA Server 4yl TDMA Encoder

2

| Flasts | \.
Wifi Vib Shooters
Flests
Y sl
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2.2 Radio Telemetry Modes — TDMA and UE Mode

The SourceLink/UE2 can operate in two different radio telemetry modes. Either TDMA
mode or UE mode can be selected. The two different modes are selected using the Encoder Settings
menu. Default mode is TDMA and is not shown in the Tracking Maps, When the UE mode is
selected it is shown in the Tracking maps.

2.2.1 UE Radio Telemetry Mode

This radio telemetry mode is compatible with older control system like thee Force Two
and Boom Box units. In this mode, there is no automatic radio collision avoidance between
different source groups or between the Encoder and the Decoder. UE2 sends an “A3 type” start
code and the Decoder units receive this “start code” and starts the decoder. After the shot or sweep
is completed, the decoders automatically send back a QC packet of data called “PSS” for vibroseis
or “PFS” for dynamite.

No GPS unit is required for this mode, the Start timing is based on the reception of the
VHF radio signal. Zero Time adjust and radio similarity adjust entries must be made to align the
starts of the Encoder and Decoder Units

2.2.2 TDMA Radio Telemetry Mode

The TDMA radio telemetry mode is all based on GPS timing; all units must have their
internal clock synchronized to GPS time. This mode requires the newer TDMA, Force III or Boom
Box III Decoder units. Older control system like thee Force Two and Boom Box units will not
operate in the TDMA mode. In this mode, the SourceLink software controls the radio telemetry
and avoids any radio collision avoidance between different source groups or between the Encoder
and the Decoder.

The Radio start codes are all based on GPS time. The UE2 system sends to the decoders
the GPS time of the start. The Decoders receive this “Start” time and automatically starts the
Decoders at the appropriate time. This digital GPS start time allows Digital Radios or multiple
repeaters to be added to the telemetry path and not affect the radio start timing.

The SourceLink software constantly polls the decoder units for their status. Status
information includes “not ready —moving”, “Pad Down — Ready”, and “PSS available”. The
SourceLink receives the status information from each group and acts on this information based on
the rules defined in the Acquisition Methods Menu.

Seismic Source Company 11
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2.3 Master/Slave/Sigma Modes

The SourceLink/UE2 can operate in either Master or Slave Modes. In Master Mode, all
operation is controlled by the SourceLink/UE2 system. In Slave Mode, a separate ‘“Master
Recorder” controls the operation and the SourceLink/UE2 monitors the Master system and
responds and monitors the master recording systems operation.

2.3.1 Sigma Master Mode

When the Sigma recording system is selected, many of the selections and operation are
moved to the Observer software. All of the Source Points, Receiver points, Processes and other
critical entries are entered only in the Observer program and are then automatically transferred to
the SourceLink software. When a shot is fired with the SourceLink software, the Shot information
is transferred to the Observer software. The Observer software uses the Shot information and finds
the “active Sigma spread” and saves the information in the Acquired shot log.

The Sigma Observer software and the SourceLink software work harmoniously together
and provide a complete Source Driven acquisition package.

2.3.2 Master —Stand-Alone Mode

The Master standalone mode allows the SourceLink to operate with complete control of
the Sources. Multiple Source groups can be controlled and the acquired shots, and Observer log
provide complete documentation of the operation.

2.3.3 Slave Modes

Various Slave Modes are available with the SourceLink/UE2 system. The UE2 can either
start on an external hardware pulse or can be started via radio. In Slave Mode, the start Message is
received from the UE2 and sent to the SourceLink software. The SourceLink/UE2 does not send
out the start codes in the Slave Mode. The system only monitors the operation and uses the acquired
PSS and PFS to monitor the crew’s performance.

When the master recorder is using the RTI (Recording Truck Interface) feature, the FFID
and other critical information can be included in the start codes. This information is received by
the UE2 and passed to the SourceLink program. With some Mater Recording systems the FFID is
not available, and the SourceLink’s FFID number must be manually synchronized to the master
recording system. The SourceLink allows the FFID value to be manually changed to allow
synchronization to the master recording system.

Seismic Source Company 12
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2.4 Installing and starting SourceLink

2.4.1 SourceLink Quick Start Guide

1) Set Fixed IP address on Computer

a) Follow instruction in IP setup instruction of the manual
b) Fixed address of 10.0.0.101 should be used

2) Setup Hardware

a) Connect Ethernet patch cable from UE2 unit to the Computer

b) Connect DC power to Radio Power cable connector on UE2 unit (11 to 18 VDC)

¢) Connect AUX inputs to Recording system

3) Install SourceLink software
a) Insert CD to your hard drive.
b) After Installation is complete then start the SourceLink software

Seismic Source Company
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There are many different selections that must be setup in the SourceLink and Sigma
Observer (optional) software.

The following is the minimum required to get started:

Load Survey Source points — use the Script menu “Survey Wizard” in all modes
expect Sigma. With used with the Sigma Observer software, the scripts are loaded
via the Observer software.

Process — The process must be setup. The process of the Dynamite, Vibroseis,
Weight Drop, or other Source parameter must be setup. This process will be used
to determine how each Source group will operate.

Groups — Number of Group Windows and assignment of unit numbers for each
group must be setup. The process must be assigned for each group.

Observer Shot Point relation file. When using the Sigma Observer system the
active receiver for each Shot Point must be setup. When using the SPS type files,
this process will be done automatically.

Load User Profile — The multiple windows can be configured in many different
combinations. It is suggested to “import” one of the default user profiles. Single
Group and Dual Group Default profiles are included in the install disk.

The following must be setup before operating the system:

Set fixed IP address on computer

Setup Prospect

Load Survey Data

Setup Process — Vibrator , Dynamite, or Weight Drop
Setup Groups — ID numbers, Crew 3, start code

Seismic Source Company 14
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2.4.2 Installing the Application

The SourceLink is delivered in an install shield format. Click on Setup.exe and follow the
instruction. After installation, you will find a Desktop shortcut and a SourceLink entry in the Start

Menu.
Important! Before installing the SourceLink, please make sure that the previous version is

uninstalled. You can uninstall the program from the Control Panel Add/Remove programs option.
Find the SourceLink in the list and click Change/Remove and follow the instructions.

2.4.3 Starting the Application

The SourceLink application can be started from the Start menu. Find the TDMA menu in
the All Programs and click on SourceLink. Upon startup, the SourceLink shows the Welcome
screen, where you can choose to open existing prospects or to create a new one.

Sigma Observer Prospect Maintenance

Praspects

cliff 5 box test pro
Cliff_Cleanpro
John Testpro
LargePropectpro
LongBeach pro
mini3d pro
| Mini3DTestpro

Andras pro ~

Praspect Description
Cassie
Client Name:
Company Name
Observer Name
Crew Name
Survey Name

Survey Date

2/25/2010 8:48 AM

PA.pro v

ProspectPath C:iSeisiSigma ProspectsiCassie

Date: Comments
3/11/20101207 AM a
3/12/2010 328 PM a

3/14/2010 1:32 PM a
3/15/201012:43 &M

a

[ mew ][ Delte [ CredeNewbay |

open | [ view |

To create new prospect, Click on the “New” button to create a new prospect.

Create New Prospect Ex

Fiospect Name: TDMA Test Prospect
Cliert Name:

Gieophysical Company Name:
Observer Name:

Ciew Name

Stait Date of Survey: Thursday , Mach 18,2010 v
Desciiption of Survey

Browse.

Bl C:/iSeis/Sigma Prospects/ TDMA, Test Prospect

Fill in the Prospect Name field, which is mandatory, and the rest of them as optional
information. The Prospect Name is the identifier that the application will refer to in respect of this
prospect. Click OK when finished entering the data.

Seismic Source Company 15
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Find the newly created prospect in the list of prospects (left hand side) and click on it. The
Prospect description window will update with the information for the selected prospect, and the list
box in the bottom of the screen will display the days/shifts that were used for this prospect. Since
this prospect is new, there is no Day/Shift information available.

Click on Open to open the prospect.
Sigma Observer Prospect Maintenance
Prospects Prospect Description

e A TDMA Test Prospect

RadioTestpro Client Name
ShotPoinfTestpro

SP1ImporTestpro
Taylor Lake pn

Teslapro
test pro
TestBuildpra
Yaughn.pro

Prospect Path

W TDMATe st Prospectpro [

Company Name:
Observer Name
Crew Name
Survey Name

Survey Date

3/18/2010 4:54 PM

C:fi8eis/Sigma Prospedis/TDMA Test Prospect

Date

Comments

open [ wew ] [ Mew |[ Dekte ][ CrealeNewDay

The New Day/Shift window will open if 24 hour passed since the last Day/Shift entry. If
this window does appear, then type your comment. We will cover the Day/Shift management and
its relevance at a later stage of this document.

Click on Submit to open the main window.

New Day/Shift [ [=1[E3]
Comments: TDM#A Testing Day 1
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2.5 SourceLink Overview

< TDMA Sho

[~ B[x

Fle  Suipts  Settings  Repots Toos Window Hep (@ Operation | [P W Tracking | [ © 8 ToMA| (B Msss| @ Source

iap Tracking Group 1 Distance: 0.06 m

@ QB[R] P | d | 1ex | Ry || objets colrs

507200
507200
507300
507200
507200
507200
507200
5073.00
507200

104700
1047.00
104600
104600
1045.00
104500
104400
104400
104300

Tine
01008033416
0101008 033353
0101008 033258
0101008033235
0101008 033101
0101008 033039 eques
aonmmze [ arss )| Fenen )
210/10/08 092851
anonmssz

2010/10/08 03:26:59

PSS Stalus

31320PH

31320 PM
31320PH

7 Figure 1

The SourceLink program consists of distinctive families of windows:

e Data Acquisition

¢  Group Management

e Vibrator Group Tracking Map

The Data Acquisition related windows are the following:

e Acquired Shots — Displays and manages the acquired source points

e The TDMA Group Manager window is called the SourceLink. It displays and
manages the groups and individual vibrators that are used for this prospect.

e The Map tracking the vibrator groups display the source and receiver points that
were imported for this prospect, as well as the vibrator or impulsive sources with
their GPS location, and the group’s COG and the distance from the closest source
point.
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2.5.1 SourceLink Toolbar

Main

File Scripts  Settngs QC Reports  Window  Help G SourceLink® Encoder

O Sigma Observer

Next FFID @ Poliing

The toolbar contains a main menu system as well as three Button

SourceLink Encoder button: Shows status of the UE2.
e LED OFF - no connection
e LED RED — UE2 connected but UE2 clock has not been set (No GPS)
e LED GREEN - UE2 connected and ready
Sigma Observer
e LED OFF - Sigma Observer software not connected
e LED GREEN - Sigma Observer software is connected
Polling
e LED OFF - radio status polling is off
e LED GREEN - radio status polling is enabled

Next FFID — displays the next FFID that will be used

Seismic Source Company 18



Seismic

Universal Encoder II User Manual
2.5.2 Tracking Map

The Sourcelink’s Tracking Maps are the main operation window used with the SourceLink
Program.

The Tracking Maps allows viewing of all of the Sources and Source Points Graphically.
When the SourceLink software is setup for source driven operation, the software will automatically
select the near Source Point and fire the shot.

In “UE mode” the ready message from the vibrator selects the near flag for the next shot
point.

Trackingl

®oH P~ | Group PullStatus | Font [10 -] | 1con [ -] [ Objects | Colors | |[Map View

'/ Group Active

Near Source Flag Group
3089/1005 4 -
Distance To Near Source Flag | FFID

4
Group Status

UE Compatibility Mode &

Sweep Number Record Length
1 N/A
Sweep Phase EP
N/A Done
Process: Sweep 1 - Single
|
e

|| Schedule Radio Similarity

Disable Auto Start

The following is shown on the Tracking Map

Near Source Point
Group number

Radio Telemetry mode
Sweep Number
Record Length

Sweep Phase

EP ID

Process status
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A single tracking Map can be used for multiple groups. This is setup using the tracking
Map selection in the settings menu. Use the “Group” pull down menu to view the status of the
other groups. When a new Group is ready the Tracking map will automatically switch to the active

group.

Right clicking on the map will pull up the following menu.

Fire
P Mew Source Flag
Mew Obiject...

& Object Editor...
¥ Clear all Ohjects

Right clicking on a Source Flag allows any Source point to be fired.

If the Shot has already been shot or the spread is not active, a warning message will appear.
The user can override the warning and fire the shot.
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2.5.3 Acquisition Coordinator

Acquisition Coordinator

£ ShotCoor dinator - 0 Active Shots, 1 Pending Shots

Line Station Sequence Sweep Sweep Progress

Pending Shats Queus

Group Time Description

313 PM Remove

The shot coordinator is the display for the currently acquiring and the pending (ready to
shoot) source points. Depending on the acquisition type there could be multiple shot points being
acquired simultaneously.

The Pending Shots Queue can have one or more source points ready to shoot.

Active (currently acquiring shot) column description:

Line: Source Point Line

Station: Source Point Station

Sequence: Required shot sequence number from the recording system
Sweep: The Sweep ID of the active sweep

Group: The ID of the source group that is used for this acquisition
EP: Shows the progress of shot point

Sweep Progress: Shows the progress of the current sweep
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2.5.4 SourceLink Manager

Sim  Unit ID Group Crew Type Status GPS PSS Pending Sweep Phase Time
Vibroseis Mo Mo 0 0 11:19:21 AM

Vibrogeis Mo Response 11:15:21 AM
Vibroseis Pad Down 11:19:33 AM
Vibroseis 1dle 111934

Encoder Status Revision Revision Date GPS  Time
» Connected 61 10f20/0011 11:23:40 AM

[ Source Link Manager | Acquisition Coordinator  Source Points  Acquired Shots. )

Column Description:
Sim: Checkbox that allows the user to specify a vibrator for radio similarity the next time
it is sweeping
Group: The assigned group for the vibrator
Crew: The assigned crew number for the vibrator
Status:
Ready: Vibrator has pad down and ready to shoot
No Response: A vibrator did not respond to last status pull. This could be a radio
problem.
Pad Up: Vibrator has its pad up
Sweeping: Vibrator is sweeping
Idle: Vibrator is Idle; SourceLink is waiting for status message
GPS: Shows if the TDMA decoder has GPS lock
PSS Pending: Indicates that there is a PPS message waiting to be transmitted from the
vibrator
PSS Status: Shows the error and warning indicators from the last PSS message. For
detailed information on the vibrator PSS check the Source Control program.
Sweep: Shows the ID of the sweep being used
Phase: Shows the phase of the sweep being used
Time: The time of the last message received from the vibrator. Yellow represents the last
vibrator that received a message. Grey represents the vibrator that was asked to send status back.
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Seismic

2.5.5 Acquired Shot Window

In the Acquired Shot Information window, the observer can inspect the position, time and
sweep information, as well as the PSS data. If a PSS message requires re-transmission, the user
can click n the Request button and the PSS delivery gets automatically scheduled and delivered.
The delta time between sweeps helps identify bottle-neck or any other sub-optimal issues that slow
down data production.

Acrpired Shoks

Une Station Sraup Sweep | Shob ID EP FID T AT woid {55 P55 Re-Transmi |
s5ze0.,00 m- = |iLosEz ke n[ spss || pequem ]I
SrEO0 | 2259.00 1 1 1009 1 000Li0E | spss || peguem |
5250.00 225600 1 sLO08 1 4338 MILfOsf=z 1T oonzls ™ 4 P55 ]l Raquact ]
525000 25700 1 sLO0T 1 &3 0IL[O5EZ 170748 omizE O 4 pss ]l Paquest ]
545,00 225700 1 1006 1 435 01105 22 165504 00:o0:ss ) 4 P55 ]l Pequest ]
E245.00 225500 1 EL00S 1 43z 000054 O] | spss ]| P equest ]
545 00 F259.00 1 HLO04 1 337 0ol | 4 PSS ]l Raquest ]
S245.00 Z260.00 1 ALO03 1 457 0005 44 O] 4 P55 “ Fequest ]
SrasOn | e | aLraz 1 4370 e O spss || pegues |
574500 FI62.00 1 gLO01 1 45379 am:oL:n= | | spss “ Raquest ]
S245.00 Z265.00 1 81000 1 4575 0o 14 O [ #rss ]| Feaquiest ]
5245 00 26400 1 an=ea i 4327 201 L{DEf22 16:44:5] a0 25 E] | 4pas “ Fr=quest ]
524500 ZEA5,00 1 il i +371 MALDEE 160 4% a0l 55 J - 4 P55 “ l R equest I
a245.00 Z206,00 1 anzey 1 +375 F1LIOSES 160041: 57 nn:nt1s _I I + F‘55 “ Ruquc‘st : l
S245.00 Z267, 00 1 AN9n 1 +07s LSRR 10417 oot n4 _I - + P55 l “ R=quest I
524500 ZE0E, 00 1 il i 457 L IDEEE 16T 00 00607 J +Pas ” R=quest I
524500 Z265, 00 1 ansg4 1 4377 A0 LIDEEER 1631 nn:ot:ne | [ + PS5 ” Request l
524500 Z270.00 1 20593 1 4321 2011 O5ZE 16:2M 5] ooz 20 il 4 P55 " Pzquest ]
524500 Z271.00 1 a9z 1 4320 201LI0SE2 162730 [H ) O | tP35 ]l Pequest ]

Line: Source Point Line

Station: Source Point Station
Group: The ID of the source group that was used for this acquisition
Sweep: Identifier of the sweep that was used to acquire this point

Shot ID: Identifier of the shot that ties the signature data with the acquired point

EP: Energy Point index
File: Field File Number associated with the sweep

Time: Exact time of the acquisition of the sweep
Delta Time: Time lag between sweeps
Void: Marks a Shot ID and FFID combination as invalid, or “void”

PSS: Shows the number of Post Service.

Status from the vibrators involved in the

acquisition. By clicking on this button, detailed information will be shown about each vibrator’s
PSS information.
Request: Re-requests the PPS information for the given shot
Comments: User and system generated comments for the sweep. This can be edited by
clicking on the field and typing in the box.
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2.5.6 PSS Displays

Various plots and reports can be selected to display the recent PSS and PFS data.

SourceLink will display vibrator performance information, when it is available, from the
PSS data. This data and display may also be called from the Acquired Shot window.

o1
= Correlation Phase Phase
20 4 B
Sh... Date Time Ne... File it ¢ [
|12 0., (37, (ofo iz, 10 4 S
12... 1., 16, 50.. 2 e Bl | vib 12
2., .. 17.. 00 12..
o 10+ Force
12... 10... 17.. 0f0 | 13...
-20
12.. 10... 17... 0f0 13.. e
0 4 B 12 1620 24 25 32 36 40 +4 45 52 56 60 64 65 72 76 &0 54 65 92 36100 1
12.. 10... 16... 0f0 | 1Z... 4 |
12... 10... 16.. 00 12. Horrekon. Force vib 12
150
19 00.0: (10 |00 (18 12 Distortion
12.. 10... 16.. 0f0 12..
n 140
19... 10... 15.. (00 |15... |||z 4
: - 5 14
12, 0. 16.. 0f0 12.. 130 e E— i
9., 10... 15, 0f0 19.. / vib 12
2. 10.. 16 00 12 120 | lunit « ™M MD vD PF RM AP MP AF MF AD MD |

0 4 3 1216202425832 36404445 5256606465 7276 5034 3592961 00040612 1620

9. 0. 15. 00 1. o rANNEEEEEEEN

12...[10..; [16... |ofo  [12.. Correlation
19...10... [15.. [0/0 |1S... 300 0 1z
N IR ~rrnt) assaaod L ) __
19... 10... 15... 0f0 | 13... ( Unit + Q Lat Lon
1% 10 (16 (o |12 20 J » 12 DiGPS 36°46.9504'N ELE
19... 10... 15.. 0/0 19.. -600 |
12... | 10... |16 (0f0 |12,
19... 10... 2L.. |0f0 0O -
. - Swp Param Avg Max Avg Min Max Avg THD Max THD
MR e SWeep (s Chks Phase ® Phase ® Force % Force % Force % % % EiEE iRy

1 1 D7 |C147 0.00 .00 |33 1] 38 2 2

Map  Messages PSS History  Observer Motes  AvgForce  MaxForce  AvgPhase MaxFPhase  AvgDistortion  Max Distortion  PFS | PSS - ShotlD: 12594

Figure 2.5.6.1 Example Display of PSS Data for One Vibrator
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When the user selects a PSS from the list in the Acquired Shot window, the vibrator
position’s from that PSS are displayed on the map.

Cursar: 4171526, 305" M, 2770056 7545 E, |

Figure 2.5.6.2 Display Locating Vibrators on Map
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Figure 2.5.6.2 Display of PSS Data for Four Vibrators (All units good)
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Figure 2.5.6.3 Display of PSS Data for Four Vibrators (One unit good)
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2.5.7 PSS Historical Display
PSS information is also displayed in historical diagrams. Each one shows the last 30

minutes of values for each vibrator along with the limits. The information includes Average and
Maximum Force, Average and Maximum Phase, and Average and Maximum Distortion.
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2.5.8 PSS Map Display

On the map, PSS information is displayed for each source point. If gray, the point has not
been acquired. If green, the point has been acquired and everything was within the set
specifications. However if the point is red, then a PSS error was detected, or else one or more of
the vibrators was out of spec.

Cursor: 1% 097 73567 N, 250455 467 E.

Figure 2.5.8.1 Map View of PSS Data
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The user can select a source point and inspect its PSS status. Status is displayed for all the
vibroseis units that were involved with the acquisition of that point, and the errors reported for the
vibrators at that station.

Source Point: 5310 - 2212
Unit: 1
Max Phase 27 > 20

Unit: 2
Good

Unit: 3

Max Phase 30 > 20

Unit: 5
Good

Figure 2.5.8.2 Detail of PSS Data showing errors
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2.5.9 PFS Displays
When a dynamite shot is acquired, the screen automatically switches to the PFS display.

The basic PFS display shows the Uphole waveform from the uphole geophone. The QC data from
the shot is also displayed.

PF5 o R X
120 -
Shot ID Shooter Time
13085 2 18:35:54 90 -
13084 2 00:00:00
13083 2 183117 i
13082 2 183:28:44 s
13081 2 00:00:00
3 13080 2 18:17:79 o-
13076 2 00:00:00
13075 2 00:00:00 =30+
13074 2 00:00:00
13070 2 00:00:00 60
431 1 20:08:31
-a0 4
-120 4
-150 - - - - - - - - - - - - - - - - - - -
1] 3 & 9 12 15 15 21 24 27 30 33 36 39 42 45 43 51 54 57
Shooter CTB Uphole  Flag Fire Line Res Geophone Res Range Limits Battery
§.000... |4.000... |0000O... 16,0052 299,56 22
Unit =« Q Lat Lon
p 2 Mf& 36%46,0779'N a7°2,9905"W

Figure 2.5.9.1 Example Display of PFS Data
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2.6 SourceLink Examples

2.6.1 Dynamite Acquisition Example

Figure 2.6.1.2 — Dynamite Data Acquisition with Warnings
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Seismic

2.6.2 Multiple Vibrator Fleet Acquisition Example
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Tracking Group 1

P (5 B Iil P | Group Settings Urits | Test | Obiscts Colers | || Pap bies | P55 W Group Active
Mo Sauroz Flag

5067/1029

Pistence To Mear Scurcs Flag | FRI

23.85m 561

Graup Status

Sweeaping =)
Saeep [nfg

Sup=en Mumber Aecord Leng

1 16000 ms
swzen Fhzse EF
0 Jof6

seduls Radia Similzety

Dis=hbil= &uko Start

Cursoet FOD0L.4331° 5, 070002, 305

PO B El P | Group Settings Urits | Test | Ohiects Colors | [

e 1 ' Group Ackive
haa Saurca Flag

5034/1026

Cistance To Me=ar Sour lag

ahoug Skatus

FFI

552

Ready D)
SAERD [N
Swzen Mumber Aecord Lengdh
2 16000 ms

Swizep Phase EP

0 1of 6
Distance 22.50%m axcesds Imit 20,00m,

Tgrare:

schecls Padia Smilznty

Disehls &uko Start

Cursoe; 3506 07 DE6E

319,496 N

Figure 2.6.2.4 — Two Vibrator Fleets, One Acquiring Data, but Fleet #2 has a Possible Location Warning
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2.6.3 Source Map

Zoomed-out display of project survey overlaid on Google Earth display.
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Zoomed-in display of project survey overlaid on Google Earth display. Terrain and
elevation information is now clearly visible. In this display, users can click on source points and
inspect PSS information.

5330.00/2077.00

nit: 2

Good

Unit: 4

Good

it 5§

Good

Unit: 1

Max Phase 88 » 20
Directions: To hara - Fram here

2102.00

(210
!]0532

00/2°1'10.00

5320.00/2111.00 5330.00/2110.00

20.00/2112.00 5330100211100
Figure 2.6.3.2 — Example of Interrogating PSS Data
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Snail-trail information helps crewmenbers to visualize drive-arounds and vibrator paths.

r
He gt Window *

RO EE8E& | ® e [vhis|@® (=] HB| 2Bk i

1.15.  Snail-trail information helps to visualize drive arounds and vibrator paths.

Figure 2.6.3.3 — Example of vibrator trails on Google Map Display.
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3 SourceLink Menus

3.1 File menu

The file menu has the following selections:

5 Source Link® Desktop

Scripts  Settings QC  Repor
] Prospect Maintenance...

Process Maintenance...

Map Underlay...
Manual Google Earth Output  »

Harvest (A5]) File »
COG Output 3
SBS Output...

Exit
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3.1.1 Prospect Maintenance

The Prospect maintenance menu allows various prospects to be loaded and saved from
disk.
Start a new project.

When the SourceLink software starts, you can start a new project or continue using an
existing project.

The CD comes with a demo project that can be viewed.

For the first operation a new project will need to be created:

Source Link® |e2
Prospects Prospect Descniption
Andraz.pro a Force Three tests Oct 25
Dale Test6-8-11.pro 1 Client Name
Defaultpro
DR test10_5PM.pro E e

DR _SourceLink testpro
Force Threetests Oct

Observer Name

m

Crew Name

Ponca City
Ponca City July 20 pro Survey Mame
Ponca.pro il Survey Date 10,/25/2011 3:21 PM
Ponca_March_25 2011 pr -
Prozpect Path C:ITDMAISigma ProspectsiForce Three tests Oct 25
Date Comments
10/25/2011 3:21 PM DDOM

v e

Create New Day

John -Dual Group-new computer 1° -

COpen ” Mew ” Delete ” Export... “ Impaort... H Hecuver...]
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3.1.2 Process Menu

The Process menu must be first setup to use the SourcelLink software.

Each process defines the type of land acquisition:

Type

Description Sweep 1 - Single
Type Vibroseis

Record Length (ms) 12000

Stack Fold 1

EFP 1 Sweep: 1

([ New ][ Modsy ][ Deete |

Select New process:

Acquisition Parameters Acquistion Type

Record Length (ms) @ Dynamite

Stack Fold | | ©) Vibrossis
() AirGun

Seismic Source Company 40



Universal Encoder II User Manual

Seismic

Define New process — Select if Vibroseis, Dynamite or Weight Drop:

o5l Create Mew Process IEIIEI
Process ID: 2
Description Vibroseis - 4 sweeps - #1.2.3.4
Acquisition Parameters Acquisition Type
Record Length {ms) 12000 | Dymamite
Stack Fold 4 @ “ibroseis
Ar Gun
Sweep Information
| Use Same Sweep for all EPs
EP Sweep
1 [1 -
2 = -
3 E -
> a4 |4 -
Start Method for subsequent EPs
1 Automatic @ Sub-Stack Delay
EFP Delayims)
1 ADDD
2 4000
& 3 | a0
A o
[ oK ] [ cancel |

Seismic Source Company
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After Defining the various Processes have been defined, the summary can be viewed:

2 Wasen ) s #1734 e Yebe
3 2
Description Vibroseis - 4 sweeps - #1234
Type Vibroseis
Record Length {ms) 12000
Stack Fold 4
EF1 Sweep: 1 Delay: 4000ms
EF 2 Sweep: 2 Delay: 4000ms
EF3 Sweep: 3 Delay: 4000ms
EF 4 Sweep: 4 Delay: Oms
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3.1.3 Map Underlay

A map underlay can be used as a background. A BMP map or a Tiff type map image can
be used. The map must be tagged correctly with the correct coordinates.

The Seismic Source “Navigator” software can be used to obtain maps in the correct format.

8 Manage Map Underlay i —|O| x|

C:h\aeismic SourcelMavigatariDakal35C _office Zmile 2011.4.4 15_29.bmp | Open |

i Diefine | 36, 7973005353255°M/-97 052 166960651 12\

36,741 709655016°N,-97, 0179100336525 Define |

4
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3.1.4 Google Earth Output

Google Earth compatible “KML” files can be output from the SourceLink software. These
files include the Vibrator/Dynamite shooter/Weight Drop units, and survey data.
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3.1.5 Harvest (ASI) File Output

The Harvest file “Acquired Shot Information” file (ASI). The ASI files are used with the
Sigma Recording system and other Seismic source and ISEIS software. The ASI file includes the
exact GPS time of each shot and can be used to download the Source Signature data from the

Source Decoder units.

ASI Output

Output file ITest Shats

— Output Filkers
— Channelz

V¥ DownChannel ¥ Mid Channel

=1k
Erowse |

v IJp Channel

— Shots and Events

£ Dutput Cument Day

= Dutput Al Days

% Filter Shots/Events

10
11
12
1z
14

3083007135700
LOEZz200/108z200
Eoz3o00/s102100
S0Zz00/7102000
S0Z300/108300

201171151
201151171
201171111
201171171
201171151

7 308900/125700 201171171 17:0:39

2 3089007135700 201171141 17:3:3 User Owerride: This shotpoint 1
9 2083007135700 Z01171141 17:4:49 User Owerride: This shotpoint
17:
17:
17:
17:
17:

1a:
14:
1&:
1%8:
zo:

38 User Owverride: This shotpoi:
El User Owverride: This shotpoi:
1a
u]
43

EFSG Code

Seizmic Sources Corparation]

T Convert Source WGS84 Positions to E asting,/Marthing and dizplay thern in the output

[The EPSG code can be obtained from http: A fzpatialreference. org or from the document supplied by

Seismic Source Company
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3.1.6 “Center of Gravity” COG Output

The Center of Gravity or COG is the average GPS position for a given Shot point. For a
single sweep Vibrator Group, then it is the average position of all of the vibrators in the group.
When the project requires multiple sweeps at the same source point, then all of the positions for all
of the sweeps are averaged together.

COG Output - o] x|
Clutput file |‘-.-fiI:| Pozitions Browsze |

V' Create Repart

I Erowse
V¥ Use these vibrators anly IE,EL'I 1] [Comma zeparated values. Example: 1,2.3]

—Iv¥ Uze SEG-F Output Format

[T Uszed digit decimal zeconds Format;

¥ Exclude vaid gmeep pozitions for zounce poinks

1 Usze M avigation Format Output

% ze bverage Walues for Dilution of Frecizion and M umber of S atelltes

£ WzewWorst Caze Yalues for Dilution of, Precision and Mumber of Satelites

] Cancel |

A
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COG Output: Outputs all acquired shots and the vibrator position related files, including
unfiltered raw shots, void shot filtered and statistical calculations for each VP. For the file format,
see Appendix A.

COG Output EX)
PSR O Ty Logsihied 11 2010 17 21 52 NavDatanav

[] Create Fepart

[] Use theze vibratars only [Caomma separated values. Example: 1.2.3]

[ ] Use SEG-P1 Output Format

I1ze Mavigation Format Output

(#) Usze Awverage Y alues for Dilution of Precision and Number of Satelites

() Usze'wWorst Case Values for Dilution of Precizsion and Mumber of S atelites

(] 4 ] [ Cancel

Output file: Enter or browse for the file location and enter the name and the extension.
Extension will be automatically added based on the output type

Create Report: Enter or browse for the file location and enter the name and the extension.
This is for diagnostic purposes only, not for production use!

Use these vibrators only: Comma separated list of vibrators to use for the COG
calculation. Use this option if one or more vibrators have different (higher) resolution GPS and you
want to filter out the rest of the units.

Use SEG-P1 Output Format: If this option is checked, the COG information will be
output in a standard SEG-P1 format.

Use 4 digit decimal seconds: If checked, the decimal seconds in the SEG-P1

format will use 4 decimal digits instead of the standard 2.

Exclude void sweep positions for source points: If checked, the SEG-P1 file will
not contain the shots that were re-acquired. (Only the latest information will be shown).

Use Navigation Format Output: If this option is checked, three files will be output with
different levels of filtering, averaging, and statistical information.

Use Average Values for Dilution of Precision and Number of Satellites: If
selected, an average will be calculated for each Energy Point, based on the information
from each vibrator that took place in the sweep.
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Use Worst Case Values for Dilution of Precision and Number of Satellites: If
selected, the worst case scenario will be displayed for each Energy Point, based on the
information from each vibrator that took place in the sweep.

3.1.7 SBS Output

The SBS output files are used with the Fairfield Node Recording system. The SBS file
include the exact GPS time of each shot and can be used to supply all of the source information to
the Fairfield Node seismic system.

SBS Output ~=ol x|
Cutput file ISBS outpLl Browsze |

— Output Filkers

— Channels

I¥| DownChannel ¥ KMid Channel ¥ @ Ehanmel

— Shaotz and Events

{*  DOutput Cument Day = Output &l Days

¥ Filter Shats/E vents

7 308900135700 EOLL1/11/1 17:0:39

g8 2028300135700 20114111 17:3:3 User Owerride: This shotpoint 1
9 3089007135700 Z011/1171 17:4:43 User Owverride: This shotpoint
10 2083900/135700 E011/11/71 17:10:38 User Override: This shotpoir
11 EOz300/108200 E011/1171 17:14:E51 User Override: This shotpoin
12 B0Z300/108100 20117111 17:16:18

1z EOzz200/102000 201171171 17:1&:0

14 EOZ300/108300 Z011/11/1 17:20:49

1 Corwert Source WiE584 Pasitions to E azting/Morthing and dizplay them in the output

EFSG Code I

[The EPSG code can be obtained from hitp:/#zpatialreference. org or from the document supplied by
Seizmic Sources Corpaoration]

Save Cancel |

A
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SBS Output: Outputs the acquired shots related information in the Concept Systems Shot

by Shot (SBS) format. For the file format, see Appendix B.

SBS Output FEX
Output file | | Browsze

Output Filkers

Channels

Shotz and Events

{(*) Output Cument Day ) Output &)l Days

Filter Shats/E vents

101 40000032400 2010,3/4 13:2:-E6
101 400000100 Z010/3,4 13:2: 56
101 4000001500 2010734 13:2:56
101 400000200 Z010/73/4 13:2:56
101 400000100 Z010/3,/4 13:3:17

101 1000002000 201034 13:3:57
101 4000003400 2010,3/4 13:3:57

[

W

Save

] [ Cancel

Output file: Enter or browse for the file location and enter the name and the extension.
Extension will be automatically added to the file name if the operator browses for the vibrator.

Filter Shots/Events: Allows outputting all the shots or selected ones only
Save: Saves the SBS file into the Output file location

3.1.8 Exit

Exit: Gracefully quits the application and saves off the window positions

Seismic Source Company
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3.2 Scripts menu
Scripts Menu

Survey Script Import Wizard...
Survey Script Export Wizard..,
Import Summary...

Mark Acquired Shot Points...

3.2.1 Survey Import Wizard

_ Survey Wizard
ol Survey Script Import Wizard EI

Welcome to the Survey Import Wizard

This wizard will walk guide you though the survey point input for receiver and shot points.

To continue, dick Mext

Cancel
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Select if pre-plot is in SEG_P1 or SPS format. _
ol Surwvey Script Import Wizard [ | i | >

Select Your Script Type
Please sclect the type of the script files

@) SEG-F1

) SPS

= Back

Cancel

When in SEG-P1 select coordinate system of the Pre-plot file

ol Survey Script Import Wizard E@I

SEG-P1 Projection
Flease select the corresponding projection type

@) I have an SEG-P1 Script in WGS84

3 1 hawve an SEG-P1 Script file that is using some other datum

< Back Cancel
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If the Preplot file has a header, then it must be marked by selecting this data with the cursor
and then pressing the right mouse button.

SEG-P1 Source Point Import
Import standard SEG-P 1 file and make adjustments to the farmat interpretation if needed

File
Source File C:\Sigma 5P 1\PONCA-TEST-Nad3 3-5RC-032309,5P 1 Browse...
Configuration File

Browse. ..

Projection System: Oklahoma North 3501 \Warming! if header information
Projection Type: Lambert Conformal Coni il Bmmmdﬂﬁ‘e File
False Northing = 0 usft, Falae ting i i Pmmﬂbaﬁ select al
Origin Latitude igin Longitude 00 5 mzﬁmm
Southern Parallel 3 5 M, Horthern Parallel 31 53 0_.0000

ZB1N0S7025763W22469617 6447667

Field Definition
L z 3 4 5 & 7 8
12345678901234567890123456789012345678901234567890123456789012345678901234567890
Datum Name: NADE3 BONCR CTY TEST 03/23/03 SRC
Line Number Station Mumber Lat/Lon Detection
Start Index Start Index Auto-Detect Latflon  Auto detect successfull
End Index End Index Lat/Lon Format Mumber of Dedmal Digits
@) Decimal Seconds [7] 1mplied Decimal Point
[ cetFromselection | [ GetFrom Selection | = .
| <Back || MNext> | | Cancel
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After the header has been marked, the Columns for the Source Line and Station must be
selected. Highlight the columns to be used and click the appropriate box. Manual entry of the
columns can also be performed. After selecting the columns, press the “preview” button to see the
first few Source Points.

1= Survey Script Import Wizard EI

SEG-P1 Source Point Import
Import standard SEG-P1 file and make adjustments to the format interpretation if needed

File

Source File C:\Sigma'sP 1\PONCA-TEST-Nads 3-5RC-032309.5P 1 Browse...
Configuration File
Eile Preview

I Waming! f header information
is being displayed in the File
Preview, please select all
header related lines and use

H Projection System: Oklahoma North 3501
H Projection Type: Lambert Comformal Conic
H Fzlse Worthing = 0.000 usft, False Easting = 2000000.000 usft

H Origin Latitude = Z5 40 0.0000 N, Origin Longitude = 100 20 0.0000 W A 2
H Southern Parallel = 30 7 0.0000 N, Northern Darallel = 31 53 0.0000 N s e
30851005 36460281N057025763W22469617 6447667 -
Field Definition
1 z 3 4 5 5 7 g

123456789012345678901234567850123456789012345675850123456785012345678501234567830

3089 36460281M097025763W22463617 6447667

Line Number Station Mumber Lat/Lon Detection
StartIndex 13 StartIndex o7 [¥] Auto-Detect Lat/Lon Auto detect successfull
End Index 4 EndIndex 55 Lat/Lon Format Mumber of Dedmal Digits
@) Decimal Seconds [F] tmplied Decimal Point
| Get From Selection | | Get From Selection | - . N . ’
() Decimal Minutes Line 0 Station 0
Preview
Line Stat lat lon - Preview
308%.00 1005.00 Cursor: 36°46'02.8099" N, 97°02'57.6297" W.
3085%.00 1009.00 Cursor: 36°46'03.4099" N, 97°02'57.58938™ W. 7
3089_00 1013.00 Cursor: 36°46'03_9999™ N, 97°02'57_5497" W. i
< Back Mext = Cancel

Browse for the SP1 file and the configuration file if it exists already. The configuration
file is automatically generated after importing and it contains the setup information that was used
at the time of the import.

After selecting the sp1 file, its content will be displayed in the File Preview section of the
window. The first line of the file will also appear in the Field definition section. The content of
this field definition window can be changed by selecting an item in the File Preview list. The
purpose of the Field Definition is to be able to customize the sp1 file import.

Line Number definition: Highlight the section on the field definition that represents the
line number and click on the Get From Selection button. The start and end index of the highlighted
text will show up in the entry fields for the Line Number.

Station Number definition: Highlight the section on the field definition that represents
the station number and click on the Get From Selection button. The start and end index of the
highlighted text will show up in the entry fields for the Station Number.

The location of the latitude and longitude information is automated. If the location of the
latitude and longitude was detected, Auto Detect Successful message will be displayed in the color
green. Otherwise the input window will be modified to display the detail information for the
latitude and longitude information.
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5P1 Receiver File Import
File
Fieceiver File

iC:'\iSeis\SFﬂ “Swath Production Survey D ata\Swath CSY WES845\S pring 506 Src 80 | ’ Browse... ]

| Browse. ..

Configuration File

File Preview

101 4 i B
SO610Z 1181E1402W 334541580 __
EO0E103 1158121306W 23424101N
LOE1l04 1121F1211W 234241910
S06105 118121115W 334541910
LOE10& 1121E10Z0W 234241910 e

Warning! [F header information
iz being dizplaved in the File
Preview, plaase zelect all
header related lines and use
right-click ta mark themn.

Field D efinition

1 Z 2 4 £ & 7 2
1z234EETE901E340678001 2340678901234 5678301234 86780901 234 LETRO01E24 5678901234567 830

SOGREERE 115121436W 33454187H

Line Mumber

Start Index [13
End Index i15

Station Number

Start Index |16
End Index i13

Get From S election ]

[ Get From Selection ]

Lat Degress
Start Index |24 |
1=

Endlindes |32 |
= |

Lat Minutes
Start Index |
art Index |33 |

EndIndes |34 |
A

Lat/Lon Detection

[] Auto Detect Lat/Lon Auto detect successful

LatfLar Farmat

(3 Decimal Seconds

Lat Seconds
Start Index |
art Indew |35 |

Endindex |35 |
= |

() Decimal Minutes

Lat Decimal Seconds
Start Indes [37 -__-|
|

EndIndes 2 |
|

]

Lat Hemizphere

Start Index [ 3¢

art Index |39—|

End Index !33 |
== |

Get From S election ]

[ Get From Selection ]

[ Get From S election

[ Get From Selection

[ Get From S election ]

Lon Degrees
Start [ndex Igg |

Endlindex |22 |

Lan Minutes
Start [ndex l 73 |

EndIndex |24 |

Lon Seconds
Start [ndex IE |

Endindex |25 |

Lon Decimal 5 econds
Start [ndex lzy |

ErdIndex  [2a |

Lon Hermizphere
Start [ndex Igg |

Endindex [2g |

Get From S election ] ’ Get From Selection ] ’ Get From S election ] ’ Get From Selection ] ’ Get From S election ]

Preview

Preview

[ Irnport H Skip ]

Select the appropriate section for the latitude and longitude degrees, minutes, seconds and
decimal seconds in a similar fashion as the Line and Station numbers were selected.

After all fields are filled correctly, check the results in the Preview list by clicking the
Preview button.

Preview
Line Stat lat lon A~ Preview
Eogs.00 101.00 Curser: 33748'41_ 263%" N, 112°12'14.9892" W =
L0500 102.00 Cursor: 33°48'4l_873%" N, 118°12'1l4.0158" W.
L0600 103.00 Cursor: 33°45'4l_305%" N, L18°12'13.0857" W. bt

When satisfied with the outcome in the preview window, hit Import to process the sp1 file.
If there are no source or receiver points in the sp1 file, the following message will be displayed.

Receiver, SP1 Input

Successfully imported 156 and merged 0 items From the SP1 file
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If there are points in the prospect already, the following message will be displayed.

. Receiver SP1 File Input

The current prospect has existing receiver points, Please select 'Yes' if you would like to overwrite the current receivers, Seleck Mo’ if you would like o merge the receiver points From this file into the prospect.
Do you wank ko overwrite the existing receivers?

Choosing Yes will allow the software to proceed and clean the previous points and import
the new ones. Hitting No will merge the new points with the existing ones.
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3.2.2 Survey Script Export Wizard

After the points have been loaded, the survey can be exported to a SEG-Y file with WGS84
coordinates. This is useful for use with other SSC products.
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3.2.3 Import Summary

Import Summary: Displays the files of the last import and the details

8 ImportSummaryForm - 0] x|

— SPS Impart

Imported
Timne Items
Count
1042872011 413:26 P 104

104282017 41313 P 132

Directary

C:40000_CalemanRd_postplot\PONCA-TEST-Mad33-REC-032303.5P1
C:40000_CalernanFd_postplot\PONCA-TEST-Mad83-5RC-032309.5P1

— SPS Impart
Imported

Time Items
Count

Directony

File

Close |

3.2.4 Mark Acquired Shots

Allows the user to manually mark a shot as acquired

57
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3.3 Settings menu

The settings menu has the following settings

|QC Reports  Window  Help

Acquisition Method...

Recording Systems...
Serial Connections 3

Source Link® Encoder Connection...

FFID Adjustrment...
Shot ID Adjustment...

Status Polling 2

Distances...

=

Colors...

Comments...

Encoder...
Groups...
Units...
Sweeps...
Sequences...

P55 Limits..,
Tracking Maps...

Google Earth Cutput Setup...
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3.3.1 Acquisition Methods

The Acquisition methods menu

Acquisition Method - 10| x|

—Acquizition Techhigue

i~ Usge Conventional Acouisition

% lze Time Separation Separation Time [mz] 3000
" lze Space Separation Separation Diztance [m] IEEII:IEI

I™ | Combine with Time Separation IEI Mhgec

™ Use Unresticted Acoquisition

" Usze Interlzave Acquisition

" Use Simultaneous Sources Humber of Groups |1 ™| Enatle [ verlaps

—Achon on Beady Mezzage

+ Show Shat Pairk in list by highlighting it and scrolling the wiew

-f;’:u'tart acquisition autommatically!

k. Cancel
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3.3.2 SourceLink Recording System Settings

The Recording system settings determine how the SourceLink UE2 system operates. In
some applications, the SourceLink must be a slave to a master control system. Other applications
like the Sigma Recording system, the information is shared with another application like “Sigma
Observer” software.

— Select Recoding System

% Stand Alone
= 0Y0 Geozpace [RTI]
i~ Sencel [SGD]

O ARAM [RTI)
~

i5eiz Sigma

Claze |
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3.3.3 Serial Connections

The Serial connection menu

| Serial Connections 3 | RETI Interface Port..,
Source Link@ Encoder Connection, .. verify Sync Interface Part...
RTI Interface port
Setup Serial Port - O] x|
Part | oM |
Baud rate |-| 200
Parity IN:::ne ;I
Diata bits Ig
Stop Bitz INl:une ;I
V' Uze this Serial Part
ok | Cse |
A

Verify Sync Interface

Setup Serial Port _ O] x|

Part | oM |
Baud rate [15200

Parity [None ~|
Data bits E

Stop Bits [MNone ~|

V' Uze this Serial Part

ok | Cse |
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3.3.4 SourceLink Encoder Connection

This window sets up the Interface to the UE2 unit. Use this menu to initialize the Ethernet
port settings used for the UE2 connections.

Source Settit _ O] x|

— UDOF Communication Settings

— TDA Encoder

— TDkA Server

Port |21 235

Set

Cloze |

4

3.3.5 FFID Adjustment

Use this menu to reset the FFID setting. This is often required when starting a new prospect
or synchronizing the FFID settings to a Master recorder.

File Number Setting _ O] x|

() Use File Mumber from Recorder
@) Use Internal File Murber

Internal File Mumber Settings

Current: 15 IEEIEI Set

¥ Increment File Murber after EVETY SWEED

Cloze |
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3.3.6 Shot ID Adjustment

This menu is used to change the Shot ID. The Shot ID is used to maintain the PSS and
PFS data base.

Adjust Shot =]y

Shat ID |15

3.3.7 Status Polling

The basic Start and Stop of the polling can be done with this Menu selection or with the
Desktop toolbar Icon.

Start
Stop
Timing...

The Polling Icon at the top of the screen shows the status of the Polling control. Green is
polling enabled, and off is no polling

Left click this Icon to switch from Polling On to Polling Off
Q SourceLink® Encoder

@ Sigma Observer
() Polling

The polling timing selects the delay between polling request. For older non-TDMA
operation (“UE mode), select 2000 minimum in safe mode.

kM Status Polling Sett _|o] x|
Palling Timing Delay [ms] Im vI

(1 High Perfarmace Status Mechanism
@) 3afe Mode Skatus Delivery Method

Pull Skaktus anly During Sweeping

Set Cancel |

4
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3.3.8 Distances

The Distance Menus select allowable distances for the Source Driven operation, and also
provides an entry for viewing text.

When zoomed out of the prospect the Text for the Flag numbers becomes unreadable and
should be disabled. This entry allows automatically disabling or enabling the text with the various
Zoom levels.

Distance Setup x|

b axirurm Distance to SOURCE Flag to start source driven acguigition(m]: I RO
Mirimumn zcreen width for the text to be vizible on map [m]: I 1000

k. I Cancel |

Y

3.3.9 Colors

This entry allows user selectable colors for the various Map Icons

Color Settings x|

— Source Color Settings
Status Color

Source Point

Sample
amedmesdy
Shot Point |

o}
-~
('
ol
=
f]
o

Default Colors
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3.3.10 Comments

Menu selection allows comment to be added

8 Acquisition Comments - O] x|
|@ Auto Comment N | I

Comrment

(£
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3.3.11 Encoder

The UE2 encoder must be setup for correct operation

- Encoder Setup E@

Start Mode
i@ Start on Shot Message

(7} Start on Bdemal Pulse Rising Edge
(71 Start on Extemal Pulse Faling Edge

Start Delay
1000 ms

Start Code Robustness

Ilse Backup Start Code

Backward Compatibility

/] Use Universal Encoder Mode

Source Signature Sample Rate
1ms | ms
Maode

n-Restricted -

Monitor Mode

LIse Encoder in maonitor made

Close
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3.3.12 SourceLink Group Maintenance

The SourcelLink Group Maintenance

a5l Group Maintenance E

GrouplD Encoder A Craw Start Code Source Type Lead Vib Process Sims GPS Units

Defautt 0 VibroSeis ) 1 gle O Al Units
2 Default 2 1 0 VibroSeis Mot Specified | 1-Sweep 1- Single |Off All Units 10
3 Defautt 3 1 0 VibroSeis Not Specified | 1-Sweep 1- Single |Off All Units 12
4 Defautt 4 i 0 VibroSeis Mot Specified | 1-Sweep 1- Single |Off Al Units 11

Group D D Automatic Similarities
Gt e

Start Code 0
T — Spedal Settings

Unit 9

= 7l || Use Single GPS Unit
Source Type  Vibroseis - Vibrator with GPS D
Process 1-Sweep 1-Single |New | Inline Offset fm] |0
Encoder  Defal Azimuth egrees] 0|
Awe Channel 1 ¥

| WiFi Grouping

[ "] Use only lead vib for ready message [ Use Wi-Fi Grouping

Lead Vibrator {11 WiFiGroupID |1

Setup Wi-Fi in Decoders |

(o (o ]
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Groups: Sets up the grouping information

i Group Maintenance

- GrouplD Start Code Source Tupe Lnits
1 1} A

[ add ][ Mode | [ Delete |

Column description:

Group ID: Identifier of the group

Crew: Crew identifier for the group

Start Code: Start code that will be used for the group

Source Type: Type of source for this group. Selections are Dynamite, Vibroseis
or Weight Drop

Units: Comma separated list of units that are associated with this group

Lead Vib: Specifies which vibrator determines when the group is ready. Not
specified means that all vibrators have to report Ready before the acquisition starts

Button description:
Add: Adds a new vibrator group to the list
Modify: Modifies the highlighted group
Delete: Deletes the highlighted group
Close: Returns to the previous menu
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Addimodify Group  [2 |[B][K]

Group (D
Crew Mumber |1
Start Code 0
Units 1234

[] Use anly lead vib for ready meszage

[] Use Single GPS Uit

Source Type | Mibrozeis L

[ Automatic Similarities

[ Ok ] [ Cancel

Group ID: Group number

Crew Number: Crew number for the group

Start Code: Start code to be used for the group

Units: Comma separated list of the units for the group

Use Only Lead Vib for Ready Message: Single vibrator number to specify which
vibrator should determine when the group is ready. If unchecked, all vibrators will have
to report ready before the TDMA Server sends the ready message to the OYO system.

Use Single GPS Unit: When checked, only the GPS coordinate from the specified
unit will be used to calculate the position of the group. This is used when only the lead
vibrator has the high precision GPS. Inline offset and azimuth can be applied to adjust the
position to the middle of the Vib array. The azimuth can be changed at any time; the
azimuth used for each acquired sweep is stored in the database.

Source Type: Specifies the type of the group

Automatic Similarities: If checked, the TDMA system automatically runs radio
similarity tests on the group’s vibrators in the specified intervals.
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3.3.13 Units — TDMA Setup Wizard

Use this selection to move the Vibrator units from group to group

8 Setup Wi-Fi . =1

Wwelcome to the TDMA Decoder
Setup Wizard

This wizard walks you khrough in setting up & new TDMA Decoder or changs
the settings in an alrsady used unit

To continue, cick Mext

= Back PoMext = | Cancel
Get ID number from TDMA or Force III unit
=lE=lbe

Current TDMA Decaoder Unit Settings

Please retriewe the current settings of the TOMA Decoder Unit From Ehe Wibrator

| < Back | I Mext = | Zancel

Set desired unit ID
8 Setup Wi-Fi S =1
Select TDMA Decoder Unit
Seleck a Unik From khe lisk belows
TOMA Decoder Unit ID
a =
= Back | [ Ples<E = | | Cancel |
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3.3.14 Sweeps

This selection allows entry of the sweep parameters in the Encoder and the Decoder units.

After entering the correct sweep parameters, then select the groups or units to send the

sweeps to.

The Force III uses an “A3” radio protocol for sweep parameters, while the Force II uses
the “Force II” radio protocol for the sweep parameters. Select if the sweeps will be transmitted to

Force II or Force IIT units.

SweepSettings

Sweep# Start Freq [Hez] End Freq[Hz] Sweep Length [s]  Sweep Type

3 1 10 a0 g
z 10 &0 &
3 10 a0 g
4 10 a0 g
) 10 &0 Ll
& 10 a0 g
7 10 &0 Ll
g 10 a0 g
9 10 &0 il
10 10 a0 g
11 10 &0 &
1z 10 a0 g
13 10 &0 &
14 10 a0 g
13 10 a0 g
16 10 &0 Ll

dBfHz
dBfHz
dB/Hz
dBfHz
dBfHz
dBfHz
dBfHz
dEfHz
dBfHz
dBfHz
dBfHz
dBfHz
dBfHz
dB/Hz
dBfHz
dBfHz

Constant

0.2 Cosine
0.2 Cosine
0.2 Cosine
0.2 Cosing
0.2 Cosine
0.2 Cosing
0.2 Cosine
0.2 Cosing
0.2 Cosine
0.2 Cosing
0.2 Cosine
0.2 Cosine
0.2 Cosine
0.2 Cosine
0.2 Cosing
0.2 Cosine

0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5

Taper Type  Stark Taper [s] End Taper [s]

0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5
0.5

Phase [*] | Status

a . Changed
1} . Changed
a . Changed
1} . Changed
1] . Changed
1} . Changed
[1} ‘ Changed
1} . Changed
1} ‘ Changed
a . Changed
1} . Changed
a . Changed
1} . Changed
a . Changed
1} . Changed
1] . Changed

S [=]
Actions
Selected Sweep
Capy ko all Sweeps

Transmit

¥4 Apply to All Groups

Force 2
Force 3

Group

b

W] Encoder
W/ Unit 1
W Unit 2
W Unit 3
K Unit 4
W Unit &
o -

4

Toggle Selection

Send

Verify
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3.3.15 Sequences

The RTI interface selects Sequences and not sweep numbers. These sequences need to be
defined for correct operation

= o] x|
Sequence | Group Swesp
> _1 =] =1
2 1 =] =1
3 1 =] =1
4 1 =] =1
5 1 =] =1
5 1 =] =1
7 1 [ =]
g 1 =1 =]
| 1 =] =1
10 1 =l =1
11 1 =] =1
1z 1 =l =1
13 1 =] =1
14 1 =l =1
15 1 =] =1
15 1 =l =1
Cloze /L;

Sweeps: Shows the sequence setup

The sequence setting associates a group with a sweep number. For example: The
OYO system specifies the SDN-A uses Sequence 1. The user needs to setup in the TDMA
Server’s Sequence Setup window what group and sweep number needs to be used for
production when Sequence 1 is received from the FMC.

Sequence Setup

Sequence Group Sweep

L) 0| L | L] D] | B | | R | B | B | e ) ) 40 | K | L6
L) 0| |1 R | B | s | )| B | e ) [ (R | R | 8

Close
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3.3.16 PSS Limits

Set the PSS limits. This will be the settings used by the SourceLink software to flag the
errors.

PSS Limits —1O0] x|

Phase Limits ———— —Force Limits ———— — Diskarkion Limiks

Mairnar |4III M azimurn ISI:I Mz Igg
Average |2 Average ISEI Average I?III|

Defaulk Ik

4
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3.3.17 Tracking Maps

The Tracking Map setup

|

lu | k2
Tracking Map Setup
Maximum Mumber of visible Tracking Maps |1 -
E Auto Switch to the current Group ;_ IJ.II
3
4
5
The Single Tracking Map setup
"c:)dglga [F]/ P | Group Puittatus | Font 7 » kon 1 » | Objects Colors | [Map View | Pss  [/iGroUpAcEVEN ’
h:t;:;ﬁos: . *
Distance To Near Source Flag FFID * ‘
23.58 m 4 #:
Group Status s
UE Compatibility Mode @ ™
Sweep Number Record Length Hora
1 N/A *
Sweep Phase P =
N/A Done 1
o

oW RS R R R B R

e
*
,
*:

%

¥ %o & ¥ F S o OB ¥
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Four Tracking Maps setup

3.3.18 Google Earth Output Setup

Automatic Updates on Google Earth can be enabled. Select the items to be refreshed on
the Google Earth Map.

GoogleMapSettings _ O] x|

Source Painks
| Erowse

0 Ctpuk Every Time Source Poinks Skatus Change
L&) Outpuk Every 5 minuktes
() Disable Source Paink Cukpuk

(@) Show Source Point Shot Status
() Show PSS Status

Wibrators
Browse
0 Ctpuk Every Time GPS Position Received
L&) Outpuk Every 5 minuktes
() Disable GPS Position Cukpuk
Close
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3.4 QC menu

The Process menu must be first setup to use the SourceLink software
Radio Similarities...

Display Settings...
PFS Graphs...

3.4.1 Radio Similarities
Radio Similarity: This will be enabled if the TDMA server is not polling for status

Radio Similarity E@@

Group (D L
nit 1D 1 W
Sweep 1 L"

Select the Group for which the similarity test needs to be executed. Select the unit within
the group and select the sweep number.
Run button: Sends the similarity test with the sweep to the selected vibrator.

3.4.2 Display Settings

Menu selects the windows that will be updated when the PSS is received
& QC Display S -|O] x|

|Ipdate when P35 received

¥ pss Display

w Force/Distortion/Phase

Close
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3.4.3 PFS Graphs
Allows viewing of the PFS data:

o
120
ShotID | Shooter | Time
13085 2 18:35:54 o0
13084 2 00:00:00 |
13083 2 18:31:17 ol
13082 2 18:28:44 |
30
13081 2 00:00:00
13080 218:17:0G g
13076 2 00:00:00 |
13075 2 00:00:00 =30 i
13074 2 00:00:00 |
13070 2 00:00:00 -60 |
431 1 20:08:31 {
o]
-1z20 -
u] 3 & 9 12 15 15 21 24 27 300 33 36 39 42 45 45 51 54 57
Shooter CTB Uphole  Flag Fire Line Res Geophone Res Range Limits Battery
_B.DDD... 4.000... |00000,., |16.00 & 299.56 @2 Inrange Qutofli... Good
Unit =« Q Lat Lon
p 2 (1Y F6°46,0779'N A7°2, 0005 "W
Messages PSS History  Observer Motes  AvgForce  Max Force  AvgPhase  MaxPhase  Avg Distortion PSS - ShotlD: 19850  Max Distortion | PFS | Map
Items shown in the PFS window include:
® Uphole Geophone Signal (Time Domain Display)
e  Shooter Number
¢ Confirmation Time Break Delay
e Uphole Time
¢ Flag (Source Point Number)
¢ Firing Line and Uphole Geophone Resistances
e Range Flag
e Limits Flag
® And shooting pack Battery Voltage
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3.5 Reports menu

The Report menu allows various reports to be generated

Fepaorts...
Productivity... *

3.5.1 Reports

Reports: Offers multiple ways to output the acquired shots related information in a human
readable and sortable format.

Reports E|
Report Forms Report Settings
| Troubleshooter report Sort Options
> Sort by DatelTirme
_:ﬁ Sensor Test Report ] Sortby Shot 1D
| Instrument Test Report LI Sort by File Number
= [1 Sortby Line/Station
_jﬁ Equipment Setup Report. ] Sortby lgnoredion lanored
"] Observer's log Report Detailed Log

l Print { Prewview:... I [ Sawe to C5Y File...

At this point, only the Observer’s log Report is relevant to the TDMA Observer.
You can choose the sorting type on the right hand. Make sure you check the Detailed Log
checkbox before running the report. There are two options to deliver the reports.

Print/Preview: Allows the user to view and print the report

Save to CSV File: Saves the report into a comma separated file, which is a standard
input format for spread sheets.

Note: Some of the columns of the Observer report are not applicable for the
OYO slave mode.

Seismic Source Company 78



Seismic

Universal Encoder II User Manual

2 Print Preview - Oblog Mar 19 2010 2-42-02

i By 3 7oom vlﬁlm B Page 1 -
Sigma Observer's log Report Friday Mar 19 2010 2:42 PM Page -1
File# Status Line Station EP  ShotID Date Time Ch Proc Reclen SR SRC Type Spread

T37 Acquireddono 4
T36 Acquiredd0no 14
T34 Acquiredd0no 34
T35 Acquiredd0on 1
741 Acguired1000 100
739 Acguiredd00o 32
738 Acguired4000 1
T42 Acqguiredd0nn 1
743 Acguired4000 15
T44 Acquired3000 47
748 Acquired1000 95
749 Acqguiredd00n 1
T46 Acguired1000 a0
T47 Acquiredd0on 34
753 Acquired300d &g
751 Acqguiredi000 100
752 Acguired40no 1
Ta0 Acquiredi000 90
754 Acquired40oo 1
Ta6 Acquired4000 1
TH1 Acquiredd0no 33
758 Acquired4000 1
TEOD Acquiredz000 73
T4 Acquiredd0on 35
TH3 Acquiredd0no 13
TBS Acquiredl000 95
TBZ Acquired30oD 44
THE Acguired40oo 1
THES Acquired40oo 37
TEY Acquired1OO0 53
770 Acquired300o 53
771 Acquiredi0oo 100
772 Acquired1OOo &7
774 Acquired40on 1
TT6 Acquired40oo 1
780 Acquired40on 1
779 Acquired3o0o 49
778 Acquiredz000 74
T84 Acquireddono 24
783 Acquireddono 17
782 Acquireddoon 1
785 Acquired4000 38
787 Acquiredd0on 1
786 Acquired2000 77
788 Acquired3o0no 62
790 Acquired3000 39
791 Acquiredd00o 20
793 Acquired4000 15
792 Acquired4000 12

101 Mar4 2010 13:02:56
101 Mar4 2010 13:02:56
101 Mar4 2010 13:02:56
101 Mar4 2010 13:.02:56
101 Mar4 2010 13:03:17
101 Mar4 2010 13:03:17
101 Mar4 2010 13:.03:17
101 Mard4 2010 13:03:37
101 Mar4 2010 13:03:37
101 Mar4 2010 13:03:37
101 Mar4 2010 13:.03:57
101 Mar4 2010 13:03:57
101 Mar4 2010 13:.03:57
101 Mar4 2010 130357
101 Mard 2010 13:04:21
101 Mar4 2010 13:04:21
101 Mard 2010 13:04:21
101 Mar4 2010 13:04:21
101 Mard 2010 13:04:43
101 Mar4 2010 13:04:43
101 Mard 2010 13:05:03
101 Mar4 2010 13:05:03
101 Mard 2010 13:05:03
101 Mar4 2010 13:05:24
101 Mard 2010 13:05:24
101 Mar4 2010 13:05:24
101 Mar4 2010 13:05:24
101 Mar4 2010 13:05:45
101 Mar4 2010 13:05:45
101 Mar4 2010 13:05:45
101 Mar4 2010 13:06:06
101 Mar4 2010 13:06:.06
101 Mar4 2010 13:06:.06
101 Mar4 2010 13:06:26
101 Mar4 2010 13:06:26
101 Mar4 2010 13:06:48
101 Mar4 2010 13:06:48
101 Mar4 2010 13:06:48
101 Mar4 2010 13:.07.09
101 Mar4 2010 13:.07:.08
101 Mard4 2010 13:.07:.08
101 Mar4 2010 13:.07.08
101 Mard4 2010 13:07:31
101 Mar4 2010 13:.07:31
101 Mar4 2010 13:.07:31
101 Mar4 2010 13:07:52
101 Mar4 2010 13:07:52
101 Mar4 2010 13:07:52
101 Mar4 2010 13:07:52

Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vikraseis
Andras 8000 2000 Vikraseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Yibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Yibroseis
Andras 8000 2000 Yibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Vibroseis
Andras 8000 2000 Yibroseis
Andras 8000 2000 Vikraseis bt

CoooD oo oo o000 OO0 o000 0000000000000 o0o0 oD o0 oODoDDoooO0oOooo
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3.5.2 Acquisition Performance Display

Productivity Reports can be shown for the day’s production.

# Acquisition Performance
Filters
Start  S5{14/2011 v To 5j26/2011 v

—@- Shots per day |
—@- Void Shots per day

S00 -

400 -

300 4

200 -

100

L B p 9 & 9B 8B 9§ 8 98 5B 8

5!14[2011 SIISIZDII 5}‘16!2011 5!1?!2011 5!13[2011 SIIQIZIJII 5!20!2011 5!211'2011 5!22!2011 Sj'23!2011 5!24!2011 5!251'2011

306
- Downtime(m)

S5/14/2011 5!15!2011 5!16!2011 5}17!2011 5/18/2011 5!19!2011 5!20!2011 5!21!2011 5!22!2011 5}23!2011 5!24!2011 5!25!2011

| shotsthour

4 May e W) 2011 ») L

SMTWTF S

50 -
40 -

1 23456 7 |[3:
@ 8 910 11 12 13 14
2|15 16 1718 19 20 21 || 20 -
Z| 22 23 24 25 26 27 28
| 29 30 31

10 -

Figure 3.5.2.1 Productivity Report for May, 2011
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Here is another example of production performance in SourcelLink. The top panel shows
the acquired source points for each day of the project. The middle section shows the time spent on
detours. It makes it easy to see how the production is affected by the drive-arounds. The bottom
panel is the hourly breakdown of the production for the day the user selects in the left hand calendar.

% Acquisition Performance

100 -

0

~@- Shats per day

5,1'26,1:2011 5,1'29,1:201 1 6,1'1,!‘&01 1 6,1'4,!‘&01 1

T T T T T T
6{7/2011 6/10/2011  6{13f2011  6f16/2011 6192011  6/22{2011

200 J278

200

100

lilis

o -

[ Downkime(m)

243

) . [ shotsfhour
50
T F
234 (|
5 6 7 8 91011 30
&l 12 13 14 15 16 17 18
% 19 20 21|22 23 24 25 20 4
26 27 28 29 30
10
o T T T
0 3 6
Figure 3.5.2.2 Productivity Report for June, 2011
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3.6 Windows menu

The Process menu must be first setup to use the SourceLink software

Window Docking Manager. ..
Default View
Manage User Profile...

Festore Factory Settings

3.6.1 Windows Docking Manager

Various screens are available with the SourceLink program. These screens can be disabled
or enabled with this menu.

Window Manager - O] x|

indiow - Wisible Docked

3 E.ﬁ.cquired Shots

Acquisition Coordinator
A Distartion

g Force

v Phase

[1ain

Map

Max Diskaortion

MMax Farce

Max Phase
Messages

Observer Notes

PF5

P35 - ShotID: 13
P55 Hiskary

Source Link Manager
Source Poinks

Tracking1

AN ANNANNSNENENNSSNSNS NS
AN EANNEN AN AN RS AR

Trackingz
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3.6.2 Default View

The Screen setup can be defined by the individual user. This selection provides a default
view for a 1920 x 1200 pixel screen.

3.6.3 Manage User Profiles

The Screens can be setup by various users. This menu provides a simple way to save and
restore different screen views.

Once the screens are setup, then the user can either “Save” or “Export” this setup.

After Exporting the Screen setup, this exported file can be imported on another computer
to provide the same view.

This menu is useful for restoring the menus to correct view, if they are accidentally changed
by a novice operator.

User Profile —10] x|

TwioEroups b

Expork Imnpork Load Save

3.6.4 Restore Factory Settings

The menu is used to restore default settings to the SourceLink software

3.6.5 Help Menu

This option displays the version information of the application. The Main version
represents the revision level of the software. The first part is the major revision, the second is the
minor revision, the third is the major build number and the last part is the minor build number. For
bug fixes the minor build number will change. If the changes are more significant, the major build
number will be incremented. If there are new features introduced, the minor revision number will
change, while if there are significant additions to the software, the major revision number will be
incremented.
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4 Force II/TDMA & Force 111

4.1 Force II/TDMA Initial Setup

Decoder Hardware and Cable Connections
e  Connect the TDMA unit to the Power, Radio, Force2, and GPS cables.
e Connect the Force II unit to Vibrator Connector panel.
¢ Make sure the Radio is connected to TDMA and not Force II unit!!

SourceLink Software controls all the prospect maintenance, fleet assignments, SP1/SPS
script import, Shot logs. Currently Source Control software is used to set vibrator sweep table and
vibrator parameters, all other setup will be carried on using SourceLink software.
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4.2 Source Control

Open Source Control Software (For complete description refer Force2 Manual)

Make sure Setup->Comm Settings option is set to “Network™ with the IP Address of the
UE2 Encoder.

" ~
Communication Setup @
Encoder Serial Port | pyatwork ,]

I Encoder IP Address 10.0.40.51 I

Log Rx Log Tx
’ Ok ] ’ Cancel ] I
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4.2.1 Source Control Sweep and Parameter Entry

The UE2 parameters can be checked or changed if needed using Parameters->Encoder
Parameters option

Enable Critical Parameters

"
ELi———t
Similarity Delay 2600 Lsec
Repeater Delay a uzec r
Recorder Interface A

Recorder Type [_SBI;:_@I_[_S_E[igI__E_!EEI_D]

Remote Fire

[High/Open

'Radio Interface

| Moarral =

Mormal -

[ Fange 1000 - 3430 msec ]
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Send the required parameters to Force II'TDMA Vibrator units, by selecting parameters-

>Vibrator Parameters option.

Vibrator Characteristics

Table.

Simple Sweeps

Radio  Advanced

Hold Down Weight EOO00
Base Plate Weight 2500
Reaction Mass Weight 3900

Accelerometer Sensitivity

[\.-"ibrator v] No[‘l V]

[ rosere ]
LCompare

Send the Sweep table to Force II/'TDMA Vibrator units by selecting Parameters->Sweep

o | | | o | o | o0 W o | e W o

Frequency Sweep Taper Phasze i
1 2w
Start, Hz  End, Hz Length, s2c Tupe Constant Type Start, sec End, sec deg 2 0
120 10 Linear 0 Cosine 0.25 0.50 0 oM 1
120 10 Linear 0 Cosine 0.25 0.50 0 4 12
120 10 Lirear 0 Cosine 0.25 0.50 0 5 13 "
120 10 Linear 0 Cosine 0.25 0.50 0 4 '
120 10 Lirear 0 Cosine 0.25 0.50 0 1
120 10 Lirear 0 Cosine 0.25 0.50 0
120 10 Linear 0 Cosine 025 080 0
120 10 -~ Linear a  Cosine 0.25 050 0
a0 Linear 0 ' Cosine 025 080 0
120 10 Limear 0 Cosine 0.25 0.50 0
120 10 Lirear 1] Cozine 025 050 1]
120 10 Lirear 1] Coszine 025 050 1] : |
120 10 Linear 0 Cosine 0.25 0.50 0 7
120 10 Linear 0 Cosine 0.25 0.50 0 e E]
120 10 Lirear 1] Cozine 025 050 0
120 10 Linear 0 Cosine 0.25 0.50 0 s
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Send the Sweep table to the Encoder by selecting Parameters->Sweep Table and choosing
the Encoder option. Note: the encoder will take longer time duration to Store the Sweep table.
Make sure the process is complete.

Simple Sweeps  Linked Sweeps Send To
Frequency Sweep Taper Phasze
11 S
Start. Hz  End.Hz Length, zec Type Constant Type Start, sec End. sec deg 2 0
Nal § 120 8 Lirear 0 Coasine 050 0.50 0 I nr
NaZ § 120 8 Lirear 0 Coasine 0580 0.50 0 4 12
MWo3 8 120 g Lirear a Cosite 0.50 0.50 a 5 1 I
No4 8 120 8 Lirear i} Cosine 0.50 0.50 a Bl 14
No& g 120 ] Linear i Cosine 050 0.50 1] 7 15
NoE g 120 8 Linear 0 Cosine 050 0.50 0 8 16
No? 8 120 ] Linear il Cosine 0&0 0.50 ] @ Tgl 916 |
Nod 8 120 8 Lirear a Cosine 0.50 0.50 a
Nod3 8 120 8 Linear a Cosine 0.50 0.50 a a
Noll g 120 g Linear ] Cozine 0.50 0.50 1]
Wall & 120 8 Linear i} Cosine 0.50 0.50 i} I
Mol2 8 120 g Lirear a Cozine 0.50 0.50 a
Nol3 8 120 8 Lirear a Cozine 0.50 0.50 a E
Nol4 8 120 o Linear ] Coszine 0.0 0.50 a
Mol15 g 120 g Linear a Cosine 0.50 0.50 a |m|
MalE & 120 g Liriear 1] Cozing 0.50 0.50 1] et
| | Compare |
[ Save | | Open 1 = | Copy Sweep I
I Sweep Table iz received by Encoder OK I
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4.2.2 Source Control Radio Similarity

Select a valid vibrator ID number (any number) in Similarities section even when similarity
is rarely used (this will allow a Similarity display if SourceLink initiates a Vibrator Similarity any
time later).

|88 Source Control - abcde
File Parameters P55 Positions Setup Help

- »

Sequences - Manual 1203

-5 1 100 e e m e e e
’Sequen:e1 ] weep 80 .
Force Two Crew 1 5t Code O k.0 1'
40 -
Groups 20 1
J-ad-s-c@-D Unit
1 it Force x
- @ -9 120.04
-2 i -10 100.0
O-3 @ -1 R s e e
@ -4 Q@ -12 v S ——
-5 o 13 2004
W -6 @ -4 —
= 3 Unit
-7 L -15
@ -5 @ -5 Distortion x

Show Simz

Index 2011 EP 1 of 1 [ Unit

P55
@ i Irit ||:rew |Sweep|5wp Ehks| Faram Ehk$|
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4.2.3 Source Control — Changing Unit ID or Crew ID

Changing Unit IDs/Crew ID Using Source Control Software

Open Source Control software in the Computer connected to the UE2.

Make sure the UE2 is communicating with Source Control Software. (Encoder OK in the
bottom tab).

Make sure the Encoder and Decoder (to be modified) are connected to radio. If there are
multiple units with same unit IDs, turn off all the remaining decoders.

Note the current Unit ID/Crew ID.

Then select, set the current and desired new Unit ID/Crew ID and send Status->Rename

File Parameters P55 Positions

Status «

™

Vib g 1

-

Request Status

Request Position

[ )
[ Status Panel |
[ )
[ )

Request \Wavelet

[ it Mumber

| H Request ]

R ename

Curment®ib & 4

LHLANEY L3

Current Crew 1D 1

Mew Wik # g
Mew Crew 1D 1

LLAMEY 3

[ Fename ]
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A confirmation message can be seen at the bottom panel

|# Source Control - test2 (=S = )
CHle Pammeters PSS Posions Setwp Help
Status <« N phase x[ll Correlation Phase Shot Info x [l
Shat :
= — 120 EV?.ED 2092 EP1
1 = R S
e il it Y Encoder Index 4196
80 2 g File Number 0
Request Status 60 5 Shot 1D 0
s a EP ID 0
204 !
Unit ‘Q ‘GPS‘ﬂme |Lat ‘Lon
orce x Correlati ce |
e Fore orrelation Forc
1200 =
Unit Number 100.0
800
g . - ,
Fiename o
CutentVb# 5 2 o
t :
urrent Vil 2 = Frequency, Hz Group
Curent Crew D 1 Line
Station
New'Vib BB
Mew Crew D
T ————
1602
a0
s Urit Sampics
P , i
Status Unit |Erew |Sweep‘Ewahks‘F’aramEhks‘ Unit ‘APh" |MPh'= |AF% ‘MF% ‘AD% |MD%| Unit |TM|MD|VD‘PF‘RM‘AP'MP'AF'MF'AD‘MD‘
L] 1 o9
START IDC ion, Unit § Crew 1

Both TDMA decoders and Force2 IDs can be changed this way.
Check the display of the TDMA decoder and force2. Make sure the unit ID and Crew IDs
match.
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4.3 Force II/TDMA setup

Make sure the Force2 unit is connected properly and boot the Force II system (refer Force
II Manual)

Make sure all the TDMA Cables are connected and TDMA Case properly grounded.

The TDMA display will show a self status check after few seconds. Make sure the Memory
(MEM) and Serial Connections (SR) are displayed “OK”. Check the GPS connectivity displayed:
with coordinates, quality of GPS, Number of Satellites, PPS (‘p’). The Radio Status (RAD) will
be “idle” (‘idl’) normally, and whenever any valid radio messages go through the radio channel
this will display “Message” (‘msg’). The description of the current activity in that particular unit
will be displayed at the bottom window.
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5 Boom Box Operation

5.1 Boom Box Operation

5.1.1 Setup in Boom Box Decoder

For Operation with UE-II, the boom box needs to be set in the VIBPRO mode.

To achieve this, Please connect the Boom Box to a computer using the Boom Box
programming cable.

Make sure to select the Setup->Comport and correct com port.

Select the Boom Box tab and press the Online Check button. The Top half window will
display that the Unit # is connected.

Now select the Decoder tab and make sure the Ready Message type is set to “VIBPRO”
and “Save and Send” to the Decoder.

BB Boom Box View = | B
File Records Setup Wiew Help
D@ K N2
Unit ID: 4, UphOlE Time: 0.0 msec CTE - None Cap Resistance was not measured! No GPS
C:\Users'SSC\Downloads\Wednesday, November 03, 2010.dbb Geophone Resistance was not measured!
|
M g } Req ‘] Comp e} Boom Box | Encoder Decoder lMonitor}
Privacy Settings: Mizcellaneous: Hardware Interface Settings:
Unit ID{1-32) |4 Start Delay (0-4000 psec) g GPS PPS Active High :"
Crew (0-250) |1 Uphole Blank Time (0-128 msec) 0 Recorder Start Active  |Low A

ki Ocor (0 E ve  [Hoh <
Sy m Uphole Window Delay (0-128 msec) Time Break Active gl
Auto Shut Down (0-255 minutes) 0 Remote Start Active High A
Mode: |Dr te Decod
e Ll o] || soeskerponty  [loma <]
Mode: |standard Detorator | | gegphone Resistance, Min | 200 Max | 400 Microphone Polarity  [Mormal =

Save Save and Send | Cap Resistance, Min g Max | 20 Option Input: Low -

1 |Rec 302/302 Index 10549/2869
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5.1.2 Boom Box Setup in SourceLink Software

Process Setup

Set a process, by selecting File->Process maintenance and create a “New” process
F

e

ol Create Mew Process

. e i

Process ID: 11

Dlescription Boom box shat test

Acquisition Parameters Acquistion Type

Record Length (ms) 6000) @ Dynamite

71 Vibroseis
| () Air Gun
| ok || cancel

Specify the required Record length in milliseconds and Acquisition type to be “Dynamite”

Group Setup

Select Settings->Group->Add and set a new group with Unit ID assigned as one Boom
Box unit per group.

-
oS! Add/Modify Group - — - ~ -
Basic Settngs Similarity Settings
Group 1D 1 | Automatic Similarities
Crew Mumber 1 Every |50
Start Code o
Spedial Settings
Units 4 - ] :
| Use Single GPS Unit
[ | =
Source Type  Chynamite - \ibratar with GPS
Process - Boom bowx shat t - Inline Offset [m]
Encoder Default Azimuth [degrees]
Auce Channel Mo -
Wi-Fi Grouping
Use only lead vib for ready message Use Wi-Fi Grouping
Lead Vibrator Wi-Fi Group ID |
Setup Wi-Fi in Decoders
[ ok || Ccancel

Also set the process to the previously created process for dynamite.
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Encoder Settings

Select Settings->Encoder
The zero times, radio polarity and other settings can be configured using this option. Press
the Send button after completing the changes.
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[ | 8]

Encoder Info

ID: IP: |10.0.41 Revision:

GPS Lock: e Comms:

y!’ Enable Critical Parameters

Delays
Zero Time Adjust: | 1660 us
Start Delay: 1000 ms
Similarity Delay: 3900 us
Repeater Delay: 0 us

Hardware Interface

Start Mode: |Start on Shot Message lfSu:uuru:e Link) -

Recorder Pre-Start:  Low -
Time Break Active: |Low -
Time Break Type: Mon-IS0 -

|Ise Backup Start Code

Radio Interface
Speaker Polarity: Mormal A
Microphone Polarity: |MNormal -
Misc
Source Signature
Sampe Rate; 2MS il =
Mode: Reqular -
Source Link

(Compatibility) i Use Universal Encoder Mode

Auto Zero Time

|Ise Encoder in Monitor Mode

Receive Compare Send

5.1.3 Settiné Zero time and énalyzing Uphole wavelet in SourceLink

The most accurate way is to use a Scope and Compare the UE2 and Boombox Time Break
pulse.
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An alternative and slightly less accurate option is to just use the Zero time time value
displayed in SourceLink ->SourceLink Manager window -> Unit number ->"Zero time” column.
This should be closer to Zero (around +/- 10 us).

Eg: If the Zero time Diff in Source Link Manger is “+100 us”. Then Goto settings-
>Encoder and subtract 100 from the current Zero time Adjust value. This will bring the Time

breaks. closer .

| Fle Suveylmport Settngs QC Reports Vindow Hep OS Link® i

onx
. — 228l
| oD Stooter |Tme | et i
N 2 a0 | 1204 A 5045.00/1077.00 1 v
o 12/00:00:00 ‘\‘ \ peeckdby i
w6 2w | 7 I 25817
5 ummn | | ‘ “‘ Ditance ToNear SourceFlog | FFID
25815 12 220209 1 ‘ \ — 66452
o4 12000000 | 60 | S0
WU 122015 | | UE Compatibility Mode ©
3 oo | © | A I s e Ry
2507 Q2T | [ | 0 N/A
%% 12 00:00:00 i ‘ ‘ 0‘ . SweepPhase ®
25006 ot | 0 | ‘ b A e N/A Done
W5 12.00:00:00 | [ Process: dynamite
25905 pamn | 2] \ “ ‘\_9“ T T
904 Lo | | - :I
W4 122N | | EEE
903 12000000 | 60 - | ‘
W3 22NN | =
0 2oooooo | % Wi Teree
s puws | o | | Disable Warings
W01 12000000 : 0‘ |
25801 12202535 | -0 - \f
W 12000000 i
2579 12 3t |40
w8 12000000
003 6 9 @ 5 1B 2 2 7 W B B N £ & 6 5 s 9
Shooter | CTB }uwe DM | DMPost iﬂag FreLneRes ;;“"""" ‘Rawe ‘l'lrits Battery
250045 2.30... 999%...| 6,000 251070 Inrange |Outfi.. Good
e £ I Uphole Wavelet(PFs) ‘=
V2 NA 256N 81436.0500°W
Zero time Comparison
| Messages PSSHstory ObcerverNotes AvgForce MaxFoce  AvgPhase  MaxPhase  AvgDistorton  PSS-ShotDD:25813  MaxDitorton | PFS | Mep
Source Link Manager o

@ Automatic StatusPul () Report Ready Messages 1§ Manual Status Pulf{ Manual PSS Pull

| Group | Crew | Type Status | Gs | pss pending
Dynamite BoomBox

Encoder | status | Revision | Revision Date | Gps | Time
» Comected 106 8/27/0012 Yes | 64n47PM

The PFS tab in SourceLink displays all the uphole,CTB,GPS information as displayed
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5.1.4 SourceLink Tracking Map setup :

You can have multiple tracking window open (One window per Shooter) or Just have one
master window open and SourceLink will automatically switch to that Shooter’s Map when a
“Ready” tone is sent from that Shooter.

Settings->tracking maps:

r© - N
o' Tracking Map Settings l (=] |ﬁ]

Tracking Map Setup

Maximum Mumber of visible Tradking Maps 1 d |

] Auto Switch to the current Group

Clese

.
Trackingl (= [ |

LLLITIML 4EE

Near Source Flag Group

5133/1009 1 -
Selected Flag ShotlD
N/A

Distance To Mear Source Flag FFID

| 10628398.65m | N/A

Radio Similarity for Unit
TEST Shot with Sweep
Dizable Warnings

Group Status
UE Compatibility Mode & |
Sweep Number Record Length *
0 N/A ﬁ
Sweep Phase EP & l
N/A 'g “
Process: dyno * H
i '
Ignore g ‘
Low Force g %
i
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5.1.5 Analog Pulse and Uphole output:

The Radio Ref output will Ouptut Pulses at 1, 1.25 and 1.5 seconds from Time break.

The Radio Sim output will Output Time Break ,CTB,Uphole from the Boombox
corresponding to the 1,1.25,1.5s references .Any minor adjustments for the 1 s pulse between
encoder and decoder can be achieved by adjusting the similarity delay value.

Shown below is a record from recorder storing at a 2ms sample rate.

&} Vibrascope - C:\Seismic Source
¥ File View Edit Acquisition Options Window Help

~

B 8 M O © @ B’

Clear Open Save | Print Preview | Stat Stop Repest | Awis FullView | MewPlot Signal Spectum Corelation VibAnalysis Distorion  Compare  Moise

5 o 2 s ¥V | = | B @0 %
Wibrator  Camment Invert Smooth Remowe DC HCF LCF Motch | Device | TieH TileY Cascade

Seismic Plots

[EREEDEERED)

w traces

Eommenl} Hecord\nfo] Plot Info Status lErrols ] Eommum:almn] Network]

(04 Sep 12 17-15.22) DAL 1238 - STAAT received -
(04 Sep 12 17:15:22) DAQ 1238 - waiting for trigger

(04 Sep 12 17.15:34] DAQ 1232 - higgered

(04 5ep 12 17:15:35] DAQ 1238 - recerving data

(04 5ep 12 17-15:40) D0 1238 - finished data transmission

(04 S5ep 12 17-15:40) Filehum: 0, ShotlD: 0, EFID: 0

(04 Sep 12 17.15:40) DAQ 1238 - finished acquistion

@ Tx@

5.1.6 SEG-Y Uphole Storage:

For each dynamite shot a backup SEG-Y file is stored in UE-II flash card with the GPS
Time, Source Point information of the shot and the Uphole Wavelet.
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6 Weight Drop Operation

6.1 Basic Configuration
6.1.1 Hardware Configuration:

Connect the RTM Encoder to radio.The UE2 should be connected to RTM Encoder using
the 25 pin and 9 pin cable.

RTM
«En:uder
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6.1.2 Setup for RTM Encoder:

Using RTM software set the RTM Encoder to standard configuration.Make sure the
Recording sytem type is selected as shown below
F

B N

Weight Drop Auto (10h) | Weight Drop Manual (11h)
Weight Drop Decoder (12h) Weight Drop Encoder (13h) | Weight Drop Fast Mode {14h)
— Privacy ~ Interface Setup:
Unit 1D (1-32): |1 _ Iﬁased =
Eone (L7 I1 Input 1: Im
Start Code: Iﬂ ,I Output 2 m
Unit(s) To Fire: T —— m
Oy [T | Soedmristy o]
Radio Start Delay (0-4000 usec): IEDD— Microphone Polarity: INurrnaI vl

oK I Cancel Apply
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6.1.3 Setup for UE2 hardware:
Set the baud rate of the RTI port in UE2 to 19200, in many cases this could be set to 57600 by
default.
The configuration can be done using Vscope software.

i —— T
Configuration - DAQ 4123 (Not Upd.“ -
T —— e i 1

.ﬂ'-.cquisiticun1 Vibratnri Trigger] Analog Output - GP'S 1 Ealibratiun1 .-’-'-.dvanu:ed1

GGEA String

Lat: N4 GPS Port Baud Rate 13200 -

Lor: M A&,

Al MAA

UTC Time: M./
Date: MAA

et Position

Apply GPS Config |

BTl Paort Baud Rate [l

Apply RTI Config

-/ ] x Eanu:el|
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6.2 SourceLink Software in Weightdrop Operation

SourceLink Software can be used as a Standalone Shooting System with
Weighdrops.Which allows for the following:
e Import Sp1/SPS file or add Source Points manually

¢ Find Nearest Source point automatically
e Store the GPS time of the Event
e Store all QC information

e Export Reports and Map files.

Fle Suvey Settings QC Reports Window Help © tnivesa Evcodert

- 9

o 8 x || Trackingl oo
Shooter CTB Uphole Flag Fire Line Res S:f""““ Range 2L éf’
P Near Source Flag Gow
b 14655 1 18:46:29 0.00/0.00 1 -
s e Selected Flag ShotlD
14657 1 3608 N/A
i Te0 | o | } || DistanceTo Near Flag FFID
0 tgaz07 | Ut +Q Lat Lon 10000000 m N/A
Group Status
UE Compatibility Mode @
Suweep Number Record Length
Mess.. PSS.. Obse. M. Maxe Mg Max.. Ag.  PS-. Mac. | PS5 | Mp 0 N/A
Sweep Phase £
| Acquired shots o N/A
| tine Sttion  Source Shotld  EP FFD  Time Process void R * | | prores e ot
5056‘00 1 14655 4 T 01211071846:09859963 4 - RIM Shot 7] I
05600 (100900 |1 14654 3 6 |20021107 164556930358 |4 - RIM Shot B[ B g
05600 (100900 |1 14653 2 6 |0L21L07 184548643173 |4 - RIM Shot g e :
05600100900 |1 14651 1 66 | 212/1107 164539843822 |4 -RTM Shot ] : DD‘?"““ B :
0500 (107400 |1 14650 2 65 20080101 000033636000 |1-VibFrocess | [1] B i
0500 07400 |1 14649 1 6 |20080101 000045456000 |1-VibProcess | [1 ||| [ UseRepeater
0E00 0900 1 14648 2 6 |W00211051630:5.216000 |1-VibProcess | [ [ Disable Warnings
0E00 (0900 1 14647 1 62 |01211051630:09960000 |1-VibProcess | [ | -
ol i J _r = d
| Acquired Shots | Source LinkManager  Acquisition Coordinator ~ Source Points Cursor: 36°46'09.0201" N, 97°03'49.9649" W.
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6.2.1 Setting RTM task in SourceLink Software:

Encoder Settings:
Settings->Encoder settings and select the mode to “RTM Slave” mode. The Start mode

should set to “Start on Falling Edge”.

Encoder Settings
= E

Encoder Info

ID: IP: Rewvision:
GPS Lock: '

I m Enable Critical Parameters
Delays

Zero Time Adjust:

Start Delay: [
Similarity Delay:

Repeater Delay:

Hardware Interface

Start Mode: | Start on External Pulse Falling Edge

Recorder Pre-Start: -Low -
Time Break Active: High -
Time Break Type: Mon-IS0O -

[] Use Backup Start Code

Radio Interface

Speaker Polarity: MNormal

Microphone Polarity: Mormal

Misc

Source Signature
Sampe Rate:

Mode: RTM Slave

2ms

Source Link
(Compatibility) E Use Universal Encoder Mode
[] Auto Zero Time
[ ] Use Encoder in Monitor Mode

Compare Send
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Process Setup:

In SourceLink Software, Select File->Process maintenance and create a new process as a
Weightdrop type.

Description RTM Shat

Acqguisition Parameters Acquisition Type
Record Length (ms) 2000 ® Dynamite

Stack Fold 4 (71 Vibroseiz
@ Weight Drop / Air Gun

0K || Cancel

Group Setup:
Select Settings->Group Settings and Set all the possible RTM decoder in the Group to the
“Units”  field and assign the Process to the process defined before.
=] 3=
— =[] = ]}
| 82 Unit Assignment = P |
Linit G1 G2 G3 Type l}perator_
1 RTM it
2 i Force Three
Source Type RTM Weight Drop -
I Process 4 - RTM Shot - |New = I
Encoder Default
A Channiel 1 . Unit ID |1 -~
[ ] use only lead vib for ready message Iype it =
Esint Mot I:I DriverfShooter test
L | |
L GPS Antenna Height f
[ Adjust Reports
GPS Antenna Height [m] | 0.00
— S —— — Il —_—
2012/11,05 18:30:25.216000 |1 - Vib Process skl Giss

1

B L T R B N [
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6.2.2 SourceLink Weightdrop Operation Sequence

Shot points:
Import the SP1/SPS files using the Script import wizard.
Line/Stations can also be added manually(Right Click on the Map and Add Source Flags)

Manual Shot Selection mode:

In this mode user can Highlight and Fire a specific Line/Station .Once the fire button is
pressed, SourceLink will wait for the start intimation from the Weightdrop units thorugh radio. After

each hit the GPS time of the shot ,Line/Station and QC information will be stored.
= Source Link® =T e S

File Survey Settings QC Reports Window Help O Universal Encoder II

: 117572012 12:28 PH

Planned: 1132 Remaining ShEEdus @ roting

o 2 x || Trackingl

Shooter CTB L OO
1334.7000 ms
e AErvE 5100.00/1008.00 ! -
T e Selected Flag ShotD
14653 1 18:46:08 N/A
o e Distance To Near Flag FFID
D e B Lat 5 [THoez8aizsm 1 1
y 1 DGPS 36°46.0735H 9752,0037"W) Group Status
UE Compatibility Mode
Sweep Number Record Length
Mess.. PSS.. Obse.. Ava.. Max.. Ava.. Max.. Avg.. PSS-. Max.. | PFS Map 0 N/A
Sweep Phase £p
BE N/A lof4 .
Line station Source ShotID Time Process Void | Rel = (||| Er——
T R R T K
505600 100900 |1 14654 3 2012/11/07 13:45:56.930355 |4 - RTM Shot = :
- Waiting for Start Cancel
505500 100900 |1 14653 2 68 2012/11/07 18:45:48.643173 |4 - RTM Shot =
5056.00 1009.00 1 14651 1 66 2012/11/07 18:45:39.943822 |4 - RTM Shot == Dihlcfnto M
= 1
505600 (107400 |1 14650 2 65 2008/01/01 D0:00:33.696000 |1 - Vib Process = T
505600 107400 |1 14649 1 64 2008/01/01 DO:00:15.456000 |1 - Vi Process = G
502300 (107900 |1 14648 2 63 2012/11/05 18:30:25.216000 |1 - Vib Process = Disable Warnings
s000 (07900 |1 14647 1 62 2012/11/05 18:30:09.960000 |1 - Vib Process J =
« i 5
Acqured shots | Source LinkManager  Acquisition Coordinator  Source Paints Cursor: 36°46'16.5104" N, 97°0332.2176" W.

Seismic Source Company 106



Seismic

Universal Encoder II User Manual

Automatic Shot Selection mode:

In this mode SourceLink will pick the nearest Line and Station based on the GPS position
information from the weightdrop sent through radio.The Tolerance distance can be adjusted using
Settings->Distance

“= Source Link®

Ele Survey Settings QC Reports Window Help

@ Universal Encodern

o » x |[Trackingl

- [ shooter cte i .|
ShotID |Shooter Time 619.9000 ms Mear Source Flag Group £
12050 e 5023.00/1082.00 1 :
N i e Selected Flag ShotiD
14658 1 20:04:22 14660 L
raenr fizmiom Distance To Near Flag FFD
14655 1 18:46:28 unt  ~Q Lat Lon 20.08 m =
Taesi RS » 1 aps 36°46.0775 97°2.0025"W Group Status
14653 1 18:46:08 Ready
14651 1 18:46:00 | Sweep Number Record Length
Mess.. PSS.. Obse.. Avg.. Max.. Avg.. Max.. Ava. PSS-—.. Max.. | prs map g N/A
Sweep Phaze ee
Gl N/A Done
Line Station Source  ShotID Ep FFID Time Process Void | Rel = (|| e——
om0 oszoa 1 e ornir vsznsorris [+ o m
w00 |w0m200 |1 1859 B 74 |201211/07 2005:16.237265 |4 - RTM Shet =k
wm00 108200 1 14658 2 73 |201211/07 200401888157 |4 - RTM Shot =
5023.00 1082.00 1 14657 1 72 2012/11/07 20:03:46.957753 |4 - RTM Shot = DEable Aldo Stad
w5600 100900 1 14655 B 70 |201211/07 1546109859983 |+ - RTM Shot = 2
o500 |10m00 |1 Lassa B 5 |2012711/07 156950358 |+ T shot = TR
soseo0  |100900 |1 11853 2 G |201211/07 1545048663173 |4 - T Shot = Disabie Warnings
sose00  |100900 |1 1ees1 \ 56 |2012n1/07 19:4539.993022 | - KT Shot (-~

Acquired Shots | Source Link Manager  Acquisition Coordinator  Source Points

== Source Link®

File Survey Settings QC Reports Window Help

() universal Encodern

-
MeLtrR - © Poliing

o & X || Trackingi o 2

Shoster CTB PP L3k |?jﬂw
St st e || 24835000 ms WearSource Flag o
14658 120:04:22 5023.00/1082.00 1
y 14657 1 20:0410 Selected Flag ShotiD
14655 1 18:46:29 14658
14654 1 18:46:16 Distance To Near Flag FFID
14653 1 18:46:08 Unit = /Q Lat Lon 20.09 m 73
14651 1184600 | * 1 s 36%46,0775H 9792,0023"W Group Status
0 1 18:43:07 UE Compatibility Mode &
Sweep Number Record Length
Mess.. PSS.. Obse.. Av@.. Max.. Avg.. Max.. Avg.. PSS-.. Max.. | PFS Map o N/A

Sweep Phase

o R
Line Station  Source ShotID 3 FFID  Time Process Void  Re
. i
502300 108200 |1 14857 1 72 2012/11/07 20:03:48.957753 | - RTM Shot =
505600 100900 |1 14655 4 7 2012/11/07 18:46:09.859983 | - RTM Shot [l
50500 100900 |1 14654 3 6 2012/11/07 18:45:56.930358 |4 - RTM Shot [ DEAdiEAo et
505600 100900 |1 14653 2 8 012/11/07 13:45:48.643173 | - RTM Shot & :
505600 100900 |1 14651 1 66 2012/11/07 18:45:39.943822 | ¢ - RTM Shot = T
5056.00 1074.00 1 14650 2 65 2008/01/01 00:00:33.696000 |1 - Vib Process [ Disable Warnings
505600 107400 |1 14549 1 64 2008/01/01 00:00:18.456000 |1 - Vib Process [ -
« . R
Acqured Shots | Source LinkManager  Acquisition Coordnator  Source Points Cursor. 36°46/09.0208" N, 97°0307.0557" W,
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Main nox

File Survey Settings QC Reports  Window Help © o -
o .
PFS O & X || Trackingl
N ‘2 £ £ L] i [F]PId]
.
P T S ms Mear Source Flag Group
v 1480 A LT 5023.00/1082.00 1 -
e T Selected Flag ShotlD
14661 1 20:16:47 5023.00/1082.00 14664
160 P Pr— Distance To Near Flag FFID.
14653 1 20:05:37 Unt = Q Lat Lon 19.74m 9
14658 1200422 | ! DGPS 3674607771 97°2,9921"W fnlpst
14657 1 20:04:10 UE Compatibility Mode 0
14655 118:46:29 Sweep Number Record Length
Mess.. PSS.. Obse.. AVG.. MaX.. AV.. Max.. Avg.. PSS-. Mac.. |PFS | Map 0 lof2s
Sweep Phase EP
Acquired Shots o N/A 20f4
Line station Source  ShotID Process Re| = ||| e ——————
5023.00 1082.00 1 2 2012/11/07 20:18:06.977960 4 - RTM Shot I
502300 (108200 |1 14663 1 78 2012/11/07 20:17:58.418092 |4 - RTM Shot = s | |
o ot
502300 (108200 |1 14661 1 7% 2012/11/07 20:16:26.750715 |4 -RTM Shot
502300 (108200 |1 14860 4 75 2012/11/07 20:05:24.507743 |4 - RTM Shet |~ [[RCY piSabie At Stait Lo B
Radio Similarityforun [1 ~]
05+ &
502300 (108200 |1 14659 3 74 2012/11/07 20:05:16.237265 |4 - RTM Shot TEST Shotwith Sweep [1 <]
502300 (108200 |1 14658 2 73 2012/11/07 20:04:01.888157 |4 - RTM Shot [ use Repeater o
5023.00 1082.00 1 14657 1 72 2012/11/07 20:03:48.957753 |4 - RTM Shot ["] pisable Warnings
505600  (1009.00 |1 14655 4 70 2012/11/07 18:46:09.859983 |4 - RTM Shot -
4 m. " 3
[ Acquired Shots | Source Link Manager  Acauisition Coordinator  Source Points Cursor: 36°45'59.5175" N, 97°03'09.2774" W.

QC Information (PFS report):
After each shot the PFS report containing the Mechanical Delay and GPS position values
will be stored.

PFS
|| Shooter CTB
ShotID | Shooter  Time
14660 1 20005:45
3 14659 1 20:05:37
14658 1 20422
14657 1 20410
14655 1 18:46:29 Unit  +|Q Lat Lon
14654 1 18:46:15 - | ¥ 1 GRS 36%46,0775'N 9772, 9925"N
14653 1 13:46:08
14651 1 18:46:00
Mess... [ Obse... Avg ... Max ... Avg ... Max ... Avg ... [kt = Max ... | PF5 l Map

RTM Sheot timing:
Weight drop event’s GPS time will be stored in both in SourcelLink and in the UE-II flash
card as a backup.

The timing of the Actual Weight drop event can be obtained from the Time Break time in
UE-II, by offsetting to — 20 milliseconds.
Tevent = Ttimebreak — 20ms
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7 UE2/Force 111 support software

7.1 Data Collector —- TDMA/Force III signature downloads

DATA DOWNLOAD (Using Data Collector Software):

Ethernet Setup (Important!!) Make sure the laptop used for data download has the Ethernet

setup configured. The laptop needs to have the Ethernet setup in 10.x.x.x network and firewall
disabled.

Data Download process:
Open Data Collector Software.
Before connecting the Ethernet cable to the TDMA Encoder/Decoder from the computer,
assign the setup information in the Data Collector Software.
Signature Settings:

Select the Signature Settings tab and assign the Reaction mass, base plate and hold down
weights based on the vibrators used.

P

- T =
~' Data Collector v. 2.16 = | B |wd S
Eile Mode Help

Operation Download Settings | Signature Settings |
Fieaction Mass Weight Flags: 0
Base Plate “Weight Load Flags ‘ |Clear Flags ‘
Hold Down YWeight 60000 hax Distance. meters 10
Accelerameter Sensitivity 25 G
0.048 s Diskz: 0 MB/s Total: 0 MEB/s WinPcap: OK
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Download Settings:

Select the download settings tab.

1. Choose the File download location, by clicking the “Browse” option in save path.

2. It is preferable to uncheck the “reset memory after download” and “Download new
files only”.

3. To download all records over a given time window, select the “By Date Range” option
and choose the Start /End dates and times for download. Note: The times are in UTC
time zone.

4. The SourceLink software can provide an “ASI” file. This file describes the times for
the given shots. Using by Event Time option to use the ASI file downloads.

Download Save Path

0 Al Records C:AUzershSSCADocumentshD ataCallectorsProspectd’,

@ By Date Range Maimum simultaneous downloads [0 - no limit) 4
From 00:00:00

VT L

Er 520~
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Download Operation:

1. Connect the Laptop to the TDMA unit and open the operation tab, make sure the Unit
number

(eg.4012) shows up in the “Units” column .If not check the Ethernet connection again.

_. Data Collector v.2.16 _ " [ [E=EER

File Mode Help

Dperationl Download Settings  Signature Settings

Active Queued Finished |
| Units 0 Pause All ] Continue All ] Restart All |Status Progress Total Good Bad ] 1
0 0 0 [

. =l
Downloading date range from 00:00:00 201105412 to 00:00:00 2011,/05/12
Sawving to CilUsers\S3C\Documents\DataCollector, TOMA,_Data_prospectd as SEG-1

Disk Awvailable 17677 MB
0.048 5 Diskz 0 MB/s Totak 0 MB/s WinPcap: OK

2. After the Unit number shows up in the “Units” Column, press the” Restart All” Button.

3. Now the Progress will show a progress bar displaying the % of data downloaded. If the
unit # of the connected unit is displayed on the “Units” Section but the progress didn’t go through
after the “restart” download. Check the date & download settings.

4. Check the Status and progress. When the download process is complete, the “Total” and
“Good” columns will reflect the number of records downloaded.

5. Downloaded files can be located at the Folder location specified in the “Download
Settings”.

6. The files are organized with Folder:”...\.\YEAR_MONTH_DAY\UNIT_NUMBER”

7. Channel Assignment:

The SEG-Y records downloaded from the TDMA has the following traces.

Decoder:

Trace 1: Reaction mass

Trace 2: Base Plate

Trace 3: True Reference

Trace 4: Time Break

Trace 5: Ground Force

Encoder:

Trace 1: Digital True reference

8. Format TDMA/UE-II Flash Card (Using Sigma-setup software):
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7.2 Sigma Setup — Formatting or resetting signature data

The signature data in the UE2, TDMA decoders or Force III electronics is stored on a CF
card in the unit.

This CF card can be reset or erased. The Erase function is the same as formatting the CF
card.

Normally the Formatting or Resetting is not required.

To Format or Reset the CF card. Connect the TDMA unit (encoder/decoder) to the
computer using an Ethernet cable and open Sigma Setup Software.

The following screen will appear. With the Box number appearing in the Sigma Unit field
(e.g. 4005 below)

If the Box number does not appear in the window, then double-check the network settings.

TS m s B s B & B & B 8 8 _a 8 N

File ICP Help

. DAQ Seﬂin95:| Sensor Teﬁtl Instrument Test | Status | Pulse Response | Test Limits | GPS Monitor| Options | Debug‘

Line [ Firmware rev. 8.569

IP Address 10.0.405
Stations {Up - Down}

[ Auto Increment Stations I

Sample Interval. msec Get Config

Record Length, sec 1

Gain E Set Config

’ Reset Memory l ’ Erase Memory l

Once the Box ID is detected, press the “Erase Memory” button, and select “OK”, and
within a few seconds the following confirmation window will appear:

r© -
Information ﬁ

| Erase completed successfully

Now reboot the TDMA/UE-II unit.
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8 SSC GPS Corrections in Single Radio Mode

8.1 Requirements:

e  Minimum firmware levels:
o Force Two Communication Board Hitachi —2.17 or later.

o Force lll DSP firmware - 14.62 or later
o RTM firmware —2.1.1.35C or later.

e RTM with 9-pin connector.
GPS reference station capable to transmit correction data at 9600 BAUD.

[ ]
Single Radio Mode will work with Force 2, Force Ill or VibPro decoders.

8.2 Operation:

The RTM is connected to the GPS reference station through the 9-pin port. The
Universal Encoder (1 and Il) radio connector is connected to the RTM radio connector

below labeled UE. The RTM cable is connected directly to the radio.

SINGLE RADIO GPS CORRECTION

[
‘ GPS REFERENCE STATION g

(9600 BAUD, NO PARITY, 8 DATA, 1 STOP

‘ RT™

—— SINGLE RADIO — REFERENCE CABLE

L ~
— RADIO Y Y FORCE 2 :T CPS
\ RADIO 2ADIO OR CORRECTION

UNIVERSAL
ENCODER
Vo RECORDING SYSTEM CABLE
/
) //
P —— ‘ RECORDING
N———| SYSTEM

INGLE RADIO GPS CORRECTION

/,/

.
U sTheRC 8/04/200
etket

10—PIN POWER/RADIO CABLE =
7
e

T

e e
E

The RTM unit listens to the Universal Encoder sending radio data and waits for a
radio start code without similarity enabled. Then the RTM waits approximately 1.5
seconds after the start code and sends the correction twice on the radio. The RTM unit
will turn on the middle led when it sends out a correction on the radio. The Force Two
receives the correction and sends the data out the GPS port to the GPS receiver.
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Note: In some situations, the RTM may send short data transmissions that
do not contain GPS reference station data. If this happens, the GPS receivers in
the vibs will not go into the differential mode. This could be caused by improper
keyboard entries, no GPS reference station data, etc. The transmissions with no
data will be about "2 second long. If the GPS reference station data is being
transmitted, the transmissions will be about 1 second long or longer. It may be
necessary to listen to the transmission using a second radio to estimate how long
the transmissions are. On some ratios, one can tell by looking at the transmit
indicator on the front of the radio.

RTM setup:

BB Hammer Encoder mode

Recording System Type hex value - FD

Ready Message Type — VibPro

Microphone polarity will have to be determined by the user which works best.

8.3 Changing the RTM Configuration Settings:

To change program settings on the RTM, use the BBview program from the

Seismic Source Company. Read below how to change the radio polarity.

1.

2.
3.
4

Connect computer to the RTM unit through the “Computer” 9-pin port on the 25-

pin RTM cable.

Power up the RTM unit up.

Start BBview.

Select the Boom Box tab, in the lower part of the BBview window.
Note: If there is no Boom Box tab visible, do these steps:

a. Click on View at the top of the BBview window.

b. Move the cursor to the words “Advanced Tabs” and a window with a list of
options should appear.

c. Click on the Boom Box item

d. Repeat steps a through c, clicking on the Encoder item.

e. You may repeat until all items are checked, but only Boom Box and Encoder
will be used in this procedure.

f.  When the desired Advanced Tabs have been selected, exit the BBview
program and restart it. After doing this, the selected tabs should be visible.

Download the parameters by clicking on the Parameters Request button.

Mﬂssages] Flﬂqm:st] Compare Boom Box |Er

Direct connection: Parameter | Yalue
On Line Check, | op. Mode Unkniown
Lnit IC 1

i Parameters Request |

Send only new IDYCrew |

Send Parameters only |
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6. Select the Encoder tab.

7. Set the Mode to BB Hammer Encoder.

8. Set Microphone Polarity as necessary for the Force 2 to receive the information.
(Note: With some radios, if Microphone Polarity is set to the wrong value, the
decoders’ GPS receivers will not go into the differential mode at all or they may
intermittently go into the differential mode. Some radios work best with the
Normal selection. Some radios work best with the Reverse selection.)

Messages] Flt:qut:sll Cumpart:] Boom Box Encoder l Decuderl WDC ] Masterl Munitur] Spy ]

Privacy Settings: Timing Sektings: Hardware Interface Settings:

Unit ID(1-32) |1 Start Delay (500-10000 msec) a0 GPS PPS Active Low r

Crew (0-2501 |0 Radio Start Delay (0-4000 psec) |0 Recorder Start Ackive  |Low h
Start Code 0 - Radio Ref. Delay (0-4000 psec) [ Time Break Active L -

Units to Fire all - Remate Start Active Lo -

Speaker Polarity Mormal -
Microphone Polarity W

Interface:
Recording system: |Sercel j

Mode:

lTl Save and Send | ety et |""'h Fro j

9. Click on Save.

10. Click on the Boom Box Tab.

11. Click on Setup, at the top of the BBview window and then click on Advanced
Parameter Editor.

12. In the left “Edit Hexadecimal Value” window near the bottom of the Advanced
Parameters Editing window, Select 17. Recording System.

IBE Harnrner Encoder
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13.

Advance Parameter Editing

In the right “Edit Hexadecimal Value” window, Enter FD.

— &

Cancel

Parameter | Dec Yalue | Hezx Walue | Bytes | IInit:
1. Unit ID 1 01 1 I
2, Crew ] oo 1 I
3, Start Code ] (] 1 MIA
4, Repeater ID 0 oo 1 I
5, Flag Mumber 0 00000000 4 I
&, Password 1] Q0000000 4 JIrS
7. Units To Fire MIA FFFFFFFF 4 Bitrmap
8, Encoder Stark Delay 500 01F4 z ==
9, Encoder Radio Start Delay 0 Qo00 z MsEC
10, Decoder Start Delay 0 Qoo0 z psEC
11, Encoder Radio Ref, Delay 0 o0a0 2 [ser
12, Uphale Blank Delay 0 Qo00 z Msec
13, Uphale Window Delay 0 Qo00 z Msec
14, Weight Drop Start Delay 0 Qoo0 z msec
15, Weight Drop PTT Delay 0 Qo00 2 [ser
16, Operating Mode 19 13 1 I
17, Recording Swskem 253 FD 1 JIrS
18. Ready Message Tvpe 3 03 1 MIA
19, Repart Type 1 01 1 I
20, WCO DAC Yalue ] oo 1 I
21, Spare 1] oo 1 JIrS
22, Weight Drop Time Ouk ] (] 1 Ser
23, Auko Shuk Down 1] oo 1 i
24, First Break Threshold Method 0 Qo00 z I
25, Weight Drop Cycle Time 0 Qoo0 z msec
26, Interface Functions 1 o0t 2 I
27, Geophone Limit Min 213 0oDs z Chm
23, Geophone Limit Max Z13 0oDs z Chim
29, Cap Limik Min 49340 _2B9 2 Chim
30, Cap Limit Max 49549 CZE9 2 Chm
31, Spare oo oo 1 I
Edit Hexadecimal Yalue:
17. Recording Syskem | FOr

14. Click on Apply and then OK.
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15. Click on Send Parameters only.

Mt:ssagt:s] Flt:quest] Compare Boom Box ] Enc

Direct connection:
on Line Check. |

Parameters Request |

Send only new IDCrew |

i Send Parameters only |

Parameter | Yalue
Op, Made nkrown
Init IC 1

16. The new microphone polarity is now in the RTM.
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8.4 NovAtel GPS Receiver Setup Notes:

1.

NovAtel programs such as CDU or GPSOLUTIONS4 can be used to program,
troubleshoot, and check the status of NovAtel GPS receivers. These programs
are available from the NovAtel web site or on software CDs typically supplied
with NovAtel receivers.

The following procedures describe using HyperTerminal, a program supplied with
Windows XP and older operating systems. HyperTerminal is usually found in the
Start/All Programs/Accessories/Communications window. HyperTerminal can be
used to program a NovAtel receiver as a reference station or rover (vib unit).

The commands listed below are the same commands that should be used if
using a NovAtel program.

NovAtel recommends doing a FRESET (Factory Reset) when changing a
receiver from rover to reference station or from reference station to rover.

After a FRESET the NovAtel receiver must reload the almanac. This may take
up to 15 minutes after satellite reception is established, before it can start
functioning as a rover or as a reference station.
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8.5 NovAtel Reference Station Setup:
1. Start up Hyperterminal in 9600 BAUD, n, 8, 1, no handshaking.

COM1 Properties

Part Settings |
Bitz per second: | v|
Data bits: | g w |
Parity: |N-:|ne v|
Stop bits: |‘I v|
FElowy contral: |N|:|ne V|
[ Bestore Defaulkz ]
[ ak. l [ Cancel ]

2. Connect computer to COM2 on the Novatel receiver with a null-modem cable.
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3. Select Transfer, Send Text File, and then select ReferenceSetup.TXT.

e
ky Fecent
Dacuments

"
L

Deszktop

)

by Documentsz

tdy Computer
<

by M etwiork,

Send Text File

Look jn: | I3 Hovatel

¥ O E

Mame Size | Twpe Crake #
Igj RoverSetupLab 1KE Text Document aria

[Z] RefPas 1KE Text Document aj15)

Ej Referencesetup 1KE Text Document aris)

Ej Refstart 1KE Text Dacurment ar1s)

[Z] RefEnd 1KE Text Document a/15)

E—j Roversetup 1 KB Text Document af1zf

[%j Sarover_setupForceTwo 1KE Text Document a1slz

Igjl WES_East 1KE Text Document rza);

E’I WES_Wesk 1KE Text Document arzs);

Ej WES_Central 1KE Text Document a1zl

E’] SSrover_setupkeb 1 KB Text Document al21/.

Ej S5ref_stationMew 1 KB Text Document al21/:

Ej Sarover_setuptest 1 KB Text Document &l20/;

=| Reset 1KE Text Document 620/ o
¢ )
File narne: |F||:uverSetup b i
Files af tppe: !_T ext file [*. THT) w | | Cancel |

4. Click on Open and the file will be sent to the GPS receiver.
5. The Novatel GPS receiver is ready for operation on COM1.

The commands that should be sent to the NovAtel GPS receiver in step 4, above,

to program it as a Reverence Station should be:

unlogall

Interfacemode com2 none rtcm

Fix position 36.72131955 -97.10404113 305.9976

Log com2 rtcm1 ontime 5

Saveconfig

Note: The latitude, longitude, and altitude values entered into the Fix position line,

above, must match the actual position of the GPS antenna.

Connect the RTM to Reference Station cable to the RTM 9-pin connector and the
Novatel GPS Reference Station COM2.
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8.6 NovAtel Rover (Vib) Setup:
1. Start up Hyperterminal in 9600 BAUD, n, 8, 1, no handshaking.

COM1 Properties

Part Settings |
Bitz per second: | v|
Data bits: | g w |
Parity: |N-:|ne v|
Stop bits: |‘I v|
FElowy contral: |N|:|ne V|
[ Bestore Defaulkz ]
[ ak. l [ Canicel ] Apply

2. Connect computer to COM2 on the Novatel receiver with a null-modem cable.
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3. Select Transfer, Send Text File, and then select RoverSetup. TXT.

Send Text File 3

Look jr: | 159 Maowatel v (% | Y =¥ G-

5 | Mame Size | Twpe Date # |
Lﬁ I'%’J RoverSetupLab 1KE Text Document aria
ky Fecent réj RefPos 1KE Text Document 15/,
Documents [Z] Referencesetup 1KE Text Document a1/
=) Ej Refstart 1KE Text Dacurment aris)
B | [Z] RefEnd 1KE Text Document a/15);
Desklop f'=:| Roversetup 1 KB Text Document 1z,
E’I Sarover_setupForceTwo 1KE Text Document a1slz
. Ejl WES_East 1KE Text Document rza);
.,-} [Z] wBS_twest 1KE Text Document ajzs):
by Documents Ej WES_Central 1KE Text Document a1zl
r.2=j SSrover_setupkeb 1 KB Text Document al21/.

— Ej S5ref_stationMew 1 KB Text Document al21/:
,E_!-IJ Ej Sarover_setuptest 1 KB Text Document &l20/;
My I:;:umputer Eﬁ Reset 1KE Text Document 61201

‘;‘] File narne: :HwerSetup b
by Metwark Files of twpe: | Tent file [ TAT) v |

4. Click on Open and the file will be sent to the GPS receiver.
5. The Novatel GPS receiver is ready for operation on COM1.

The commands that should be sent to the NovAtel GPS receiver in step 4, above,
to program it to be a Rover (Vib, etc.) should be:

Unlogall

fix none

Interfacemode com1 rtcm novatel

com comi1 19200,n,8,1

log com1 gpgga ontime 1.0

log com1 gprmc ontime 1.0

log com1 gpgsa ontime 5.0

dgpstimeout 500

saveconfig

Connect the WF2NV3-2 cable from the Novatel GPS receiver COM1 to the Force
Two GPS 9-pin on the small end of the unit.

There was a Force Two hardware modification to make it possible for the Force
Two to send GPS correction data to the GPS receiver. The wire connected to pin 2 of the
GPS port was replaced with a wire going to the backplane, Modem A23.
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1
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140,;
3150-— a
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160, —O .
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RTM oo —0
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o—r
19 2
S0 O ue
— S-pin Male
.0 O RSBiBiREse
ot 1%
215 O
5 E
= L2
220
10 [
23~ ]
11 0_
Edo___
:12 [ 19 Feet o Ground
250_ SA
S| Power
ol cf\p L +12y
_— 9—me DSUB Female RTM Settings:
9-pin DSUB Female WD Encoder
T2 Recording Sustem @xFD
06__ Ready Msg Type - VibPro
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2 Speaker Normal
O Reference Station
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3
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R . .
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o . .
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8.7 Setting up the Trimble BX982

Base (Reference Station/UE) and Rover (decoders)

This section contains the information to setup the Trimble BX982 GPS receiver as a RTCM
reference station and setup the serial ports to send out RTCM corrections to the RTM2 and NMEA
strings to the Universal Encoder 1I.

The computer Ethernet adapter, Internet Protocol Version 4 (TCP/IPv4) has to be set to ‘Obtain an
IP address automatically’

Internet Protocol Version 4 (TCP/IPv4) Properties H

General | Alternate Configuration

You can get IP settings assigned automatically it your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(@ Obtain an IF address automatically:
() Use the following IP address:

(@) Cbtain DMS server address automatically

(1 Use the following DMS server addresses:

Validate settings upon exit Advanced...

carel
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Connect the Trimble 57168 adapter to the BX982 26-pin HDSUB. Connect the power supply to
the adapter. Connect the Ethernet patch cable to the adapter and to the computer.

= Power Supply
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Open up a web browser and enter ‘169.254.1.0’. Press Enter.

Username: admin
Password: password

iexplore.exe

The server 169.2534.1.0 is asking for your user name and password, The
server reports that it is from Trimble.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn't secure.

ladmin

& [

Remember my credentials

To change the Reference position, click on Receiver Configuration and then Reference Station.

8 hittp://169.254.1.0/ 2 = & || & Trimble - 2015-04-30T22:05... %

i Eile Edit View Favorites Tools Help

ﬁ - * [ @ * Page~ Safety > Tools~ @vﬁ@aa@
Reference Stationg

Receiver Status

Satel!ltes : CMR ID- D
Receiver Configuration RTCM 2.x ID:

RTCM3xID:0 |

Station Name: [CREF0001 |
Sietion Corle| |
|Vector |
_
Reference Latitude: 36 46 [la61226 [ @NOS

Reference Longitude: [97  [°|3 037141 ' OE@W

General | |
RS E (]

|Reset | Here Load Current Position
Default Language

/O Configuration

Omni3STAR

Network Configuration
Security

Firmware

Help
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Enter the Reference Latitude, N/S, Reference Longitude, E/W and the Reference Height. Then
click on OK.
Most GPS receivers calculate and send the position in WGS84 coordinate system. The Reference
position is generally in the WGS84 coordinate system.

The new Reference position is now in the BX982.
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Tracking menu.

) Tracking@

Receiver Status

Satel!ltes : Elevation Mask [10 [°
Receiver Configuration Everest™
SRS
Cwe s Eme  optos
(Vector | ) -
oPS _|L1-CiA
GPS L2E [L2C and L2E V|
GPS L2C
(General |
GPS Lo O
SBAS |L1-CA| &
Default Language |
Default Language SBAS L5 0
/O Configuration GLONASS | L1 - C/A 7
OmniSTAR : GLONASS| L1P ¥
ekl Ll LU | (GLONASS|12-CA| ¥ |[L2-CAM)Ony V]
Security GLONASS| L3 0
Firmware QzSs | L1-CIA
Help
Q7SS |L1-SAIF
Q7ss L2C
Q7SS L5
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The PPS has to be turned on. Click on Receiver Configuration and then General.

*) General@

Receiver Status

Satellites Enable Shared Port: ® Serial 3 O CAN 1 O Event Markers 2
Receiver Configuration Event 1 On/Off Event 1 Slope
Posifion Anten Operation Mode Automatic MBase output
(GRS Enatle V] 1PPS Always On

0K [ Cancel

General
Application Files

Default Language

Reference Station setup above. Decoder (vibrator truck, backpack, etc.) setup below.

Generalg
Enable Shared Port: ® Serial 3 © CAN 1 C Event Markers 2
Event 1 On/Off Event 1 Slope
Operation Mode [Rover v| Automatic MBase output
1PPS On/Off 1PPS Always On
| oK | Cancel |

Enable 1PPS On/Off and 1PPS always on.
When using as a reference station have the Operation Mode in Base. If being used in a vibrator or
backpack use Rover.
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Set up the serial ports. Click on I/O Configuration.

8 http://169.254.1.0/ P - & || 8 Trimble - 2015-04-30T22:08...

 File Edit View Favorites Tools Help

(B B0 S~ s Sreys Toos- @ B O
=) /0 Configurationg

Receiver Status
Satellites
Receiver Configuration
/O Configuration

Port Summary
OmniSTAR
Network Configuration
Security

Firmware

Help

COM1 (19.2K-8N1)
Serial COM2 (38 4K-8N1)
Serial COM3 (38 4K-8N1) 3
Serial COM4 (9600-8N1) - RTCM

NMEA-GGA(1Hz), NMEA-RMC
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Click on Serial by COM1. Setup COM1 as below for UE and then click on OK.

8 hitp://169.254.1.0/

D~ C || @ Trimble - 2015-04-30T22:09... |

File Edit View Favorites Tools Help

ta - ~ ] dm v Pagev Safetyv Tools~ i@~ I I @& o
) /O Configurationg

Receiver Status

Satellites [Serialt / COM1 v| [NMEA v|
Receiver Configuration
VO Configuration Serial Port Setup
Baud 15200 ] Party. [T 7]
OmniSTAR Input/Output
Network Configuration
Security Output:NMEA-GGA (1 Hz), Output:NMEA-RMC (1 Hz)
Firmware NMEA
Help
AVR:[0fF V] GGA:[1Hz v| GST:[of _ v| RMC:[1Hz V|
BPQ:[offi v| GGK:[off  wv| GSV:[off v| ROT:[off V]
DG [of V] GLL:[of _~| HDT:[of v VGK [ofi V]
DP:[ofi v| GNS:[off  v| LLQ:[off  v| VHD:[of |
DTM:[Ooff  ~| GRS:[Off  v| PJK[Off V| VIG:[off V|
GBS:[Off v| GSA:[off  v| PJT:[off  v| ZDA/[off V|
Standard
® NMEA

OIECE61162-1:2010

Variations from standard

[ 1Report max DQI=2 in NMEA GGA string

[1Report max correction age 9 sec in NMEA GGA string
[1Report extended information in NMEA GGA and RMC strings
[1Report GST message always as GPGST
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Setup COML1 as below for Force2, Force III, Boom Box 3, RTM3, VibPro HD, UE2 and then click
on OK.

/O Configurationg

|Serial1 / COM1 v| |INMEA v|

Serial Port Setup

Baud: Parity-
Input/Qutput

Output:NMEA-GGA (1 Hz), Output:NMEA-GSA (5 Sec.), Output:NMEA-RMC (1 Hz)
NMEA

AVR:[of  v|] GGA'[1Hz v| GST:[0f V] RMC:[1Hz V]
BPQ:[Of V| GGK/[OF V] GSV:[off V] ROT:[of V]
pG:[0f | GLL[of V] HDT:[of V] VGK:[of ]
OP:[off V] GNS:[of V] LLQ:[of v VHD:[or V]
DTM[of V] GRS:[0F _v] PUK[oF | VIG[off V]

LIRSS IESE

GBS:[0F V] GSA:[5Sec v| PJT:[0F V] ZDA[OF V]
Standard
® NMEA

CIEC61162-1:2010
Variations from standard
[ IReport max DQI=2 in NMEA GGA string
LI Report max correction age 9 sec in NMEA GGA string
LI Report extended information in NMEA GGA and RMC strings
LIReport GST message always as GPGST
| 0] 4 | | Cancel |

Seismic Source Company 132



Seismic

Universal Encoder II User Manual

Click on Serial by COM4. Setup COM4 as below for the RTCM Reference Station and then click
on OK.

e@‘ B http://169.254.1.0/ p~-C H {8 Trimble - 2015-04-30T22:

File Edit View Favorites Tools Help
ﬁ R = gég | Page v Safety> Tools~ l@lv _,Fﬂﬂ mm g F

- 1/O Configuratiﬁng

1
i,

=

Receiver Status

|Serial4 / COM4 v||RTCM v|

Receiver Configuration

Serial Port Setup

Baud: Parity:

/O Configuration

OmniSTAR

Input/Qutput
Network Configuration
Security QOutput:RTCM
Firmware RTCM
Version: Type:
Record Type 3110 Sec. v|
GLONASS Datum:|Pzao  w

OK Cancel

The Trimble BX982 is ready to send NMEA strings out COM1 and RTCM corrections out COM4.
Connect to the UE2 and the RTM2.
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Newer BX982 firmware will look like below. The Type changes from DGPS to DGNSS.

< /0 Configurationg

Receiver Status

Satellites [Seriald / COMd4 v|[RTCM v|
Receiver Configuration
/O Configuration Serial Port Setup

Port Summary )
Baud Parity
Lol Input/Output
Network Configuration
Security Output:RTCM
Firmware RTCM
Help

Version: Type: [DGNSS
Record Type 3110 Sec. v|

GLONASS Datum{PzZano w

0K Cancel
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WRTMREFIT-1

TRIMBLE BX982

REFEREMNCE STATION & TIME §¥NC TO UE Il
PORT4  DATA/POWER

wewr_macior  UE I
POWER/RADIO GPS FEMALE

Anan

WRTMRADREF-1

MOTOROLA GM140

COMPUTER

".CONNECTED ONLY FOR ADJUSTING PARAMETERS

The above diagram shows how the Trimble BX982 is cabled to the UE2 and RTM?2 for single radio
GPS corrections.
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9 Ethernet Setup

Normally, it is necessary to set up a fixed TCP/IP address for the computer to communicate
with the DAQIink IIT unit.

IP Address SET to FIXED IP ADDRESS -10.0.0.99

All Firewalls Disabled

9.1 Windows 7 Ethernet Setup

Make sure the Computer IP address is in 10.x.x.x network (eg.10.0.0.99) and all firewalls
disabled.

If computer has not been setup for this IP address:

Go to the Network Connections in Control panel.

For Windows 7 : Go to Start->Control Panel->Network and Internet->View Network
Status and tasks->Change adapter settings->Local Area Network->Right click and select properties

L Lk
@u?| i-' « Metwork and In... » Metwork Connections » - |4¢| | Search Network Connections
E
Organize * Disable this network device Diagnose this connection  » Bz = O
[/1= ' Local Area Connection = TATAPHOTON+
"’. Unidentified network l" = _ Disconnected
W~ Intel(R) 82567LM F—————— My Mobile Connect - Modem
_ | Hg  Disable
L. Wireless Metwork)
— o seismic 5 Sl
edﬂ] Intel(R) WiFi Link Mhagnose

® Bridge Connections

Create Shortcut
Delete
'E‘_-;' Rename

H  Properties
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Local Area Connection Properties ? @

General | Advanced |

Connect uzsing:

| BB IntelR) 82567LM Gigabit Netwaork Co ‘

This connection uges the following items:

gEIient far Microsoft Networks

.@ File and Printer Sharing for Microsoft Metwaorks
Bl (105 Packet Scheduler

% Internet Protocal [TCRAP)

Install... Unirztall Propertiez

Description

Transmizzion Control Protocol/lnternet Pratocal. The default
wide area network, protocal that provides communication
across diverse interconnected networks.

Show icon in notification area when connected
MHatify me when this connection haz limited ar no connectivity

ak. Cahicel

Select Internet Protocol Version 4 ->Properties and set
Use following IP-> IP address: 10.0.0.99, Subnet Mask: 255.0.0.0

Internet Protocol (TCP/IP) Properties

General |

You can get IP settings azsigned automatically if your netwaork, supports
thiz capability, Dthenwize, you need to ask your network. administrator for
the appropriate [P settings.

(") Obtain an P addiess automatically
() Usze the following IP address:

IP address: (100 .0

w
[¥=]

Subnet mask: | 255. 0 .0

=

Default gateway: |

Obtain DMS zerver addrezs automatically
(%) Use the following DNS server addresses:
Freferred DNS server | ] ’ ; |

Alernate DMS zerver | 3 i ; |

I Ok ” Cancel ]
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Computer Firewall:

To program the TDMA, all firewalls needs to be turned off.

Start->Control Panel-> System and Security->Windows Firewall and turn it off. This is
very important as the firewall will block the communication.

It is sometimes necessary to reboot the computer to have the new address take effect.

If the UE2 unit was previously communicating with a computer with a different address,
then the UE2 unit must be reset (power off then on) for the unit to communicate to the new address.
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9.2 Windows VISTA Ethernet Setup
IP address setup must be set to a fixed IP address and all firewalls must be disabled.

Disable the Windows Firewall by selecting the Firewall selection in the “Network and
Internet” selection in the Control Panel

With Windows Vista computer, the Ethernet setup is done by the following procedure:
Go to the Control Panel and select “View network status and tasks”.

~—~ Il
O@v + Control Panel » P|

File Edit View Tools Help

s Control Panel Home - g
) System and Maintenance User Accounts
Get started with Windows @ Add or remove user accounts

-

Fs

Back up your computer

|'/ Security
Check for updates
Check this computer's security status

@ Allew a program threugh Windows
Firewall

ﬁ.. Network and Internet
_lhl Connect to the Internet

= View network status and tasks

Appearance and

Personalization I
Change desktop background
Customize colors

Adjust screen resolution

Clock, Language, and
Region
Change keyboards or other input E

Set up file sharing methods

e
Hardware and Sound i Ease of Access
Play CDs or other media automatically Let Windows suggest settings

Printer Optimize visual display

Mouse

Additional Options

Programs
Uninstall a program
Change startup programs

Recent Tasks
View network status and tasks

Iy Allow a prograrm through

Windows Firewall Mobile PC
Let Windows suggest settings Change battery settings
Adjust commaonly used mobility %

Select “Manage network connections”
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e ee—

File Edit View Tools Help

Tasks :
= Network and Sharing Center

View computers and devices

View full map
Connect to a network

Manage wireless networks @ EF:II * U

Set up a connection or network : -
JOHN-ARGOMAUT Unidentified network Internet

(This computer)

\ Diagnose and repair

5‘ Unidentified network (Public network} Customize
Access Local only

Cennection Local Area Connection View status

23 Sharing and Discovery

Metwork discovery © Off @

File sharing < Off @

Public folder sharing © Off @

Printer sharing © Off (no printers installed) (9
o Password protected sharing @ On @
Inteérnet Options Media sharing o Off

Windows Firewall

Show me all the files and folders [ am sharing
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Right Click on the “Local Area Connections” and select ‘“Properties”

@Ov =& « Network and Intel

File Edit View Tools Help

’_L - 8 . —
y = i_@ <« Network and Internet » MNetwork Connections »

File Edit View Tools Advanced Help

Tasks ‘ Organize ¥ G= Views vork dev L4 Dhagnose th

View computers and devices MName Status Device Name Connectivity Metwork Categony

Connect to a network LAM or High-5peed Internet (2)

Manage wireless networks - | Local Area Connection . | Wireless Network Connection

Unidentified network . Mot connected

Set up a connection or network Agere Systems ET-131x PCI W] Tetol/DY DA Abfiealece J045A.
Disable

Manage network co

: . Status

Diagnose and repair )

Diagnose

Bridge Connections

Create Shortcut
Delete

Rename

Properties

It is also recommended to disable all other Network connections. Highlight the other
Network Connections (like Wireless) select “Connectivity” and Disable.
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Highlight the “Internet Protocol Version 4 (TCP/IP)” and Click on Properties button.

Use following IP address:
IP address 10.0.0.99
Subnet Mask  255.0.0.0
Press OK to accept entries.

Internet Protocol (TCPJIP) Properties

General |

Y'ou can get [P zettings azsigned automatically if pour network, supparts
thiz capability. Othenwize, pou need to azk vour network, administrator for
the appropriate P settings.

) Dbtain an P address automatically
() Uze the following IP address:

IP address: [10.0 .0 .9

|
Subriet mask: | 2%5. 0 .0 .0 |

Default gateway: |

s e AT e et
o zerver address autamaticall

(%) Uze the fallowing DMS server addresses:
Preterred DNS server: ; . . |

Alternate DMS zerver: | : d : |

[ ak. l[ Cancel ]
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9.3 Windows XP Ethernet setup

With Windows XP computer setup in classic mode, the Ethernet setup is done by the following
procedure:

Go to the Control Panel and open the Network Connections.

g Control Panel |._||E 5
File Edit Wiew Favorites Tools  Help .a'

Oﬁiack @ - Lﬁ ):j Search l-Ei‘ Folders v

i Address |E’ Cankral Panel

v|Gu

y ¢t T D W O %
v
ﬂ" Control Panel 2 == E ‘m
Accessibility  Add Hardware Add or Administrative  Aukomakic Awankzo
E} Switch bo Category Yiew Options Rema. .. Taols Updates Connect
- = o
See Also j g\ [: ﬂ E
CSMW Date and Time Display Falder Cptions Fants Game
& windows Update Cantrollers
) Help and Suppart INTEL > .i o
W P2 <& = O O
Intel{R} Internet Java Plug-in Keyboard Mail Mouse
PROSet ... Options

Phone and  Power Options  Printers and QuickTime  Regional and
Madern ... Faxzes Language ...

e L % u @ e

.Y fr . .3 e i -

Seismic Source Company 144



Seismic

Universal Encoder II User Manual

Right Click on the Local Area Connection Icon and select properties.

% Network Connections

File Edit ‘Wiew Fawvorites Tools Advanced Help

@Eack - \__,)I l.ﬁ: pSearch ||~ Folders *

: Address |‘:‘__ MNetwork Connections

Metwork Tasks ﬂ ’1 & |_ :lr

1394 Enable Wireless
Conneckion Skakus Mebwork. ..

i

Other Places

Create Sharkouk

Contral P |
9’ ontrol Pane Delete

ﬁg My Mebwork Places
£} My Documents
"a My Cormpuker

Fename

Properties

Scroll Down to the Internet Protocol TCP/IP selection and click on this icon.

Click on Properties button.
Use following IP address:
IP address 10.0.0.99
Subnet Mask  255.0.0.0
Press OK to accept entries.

Local Area Connection Properties [ | ‘5| Internet Protocol (TCP/IP) Properties
| General Advanced | General
Connect uzing: ou can get IP settings azsigned automatically if your network, supports

thiz capability, Otherwize, pou need to azk pour network, administrator for

‘ B8 Iniel[R] 825671 M Gigabit Nebwork Co ‘ the apprapriate P setings.

This connection uses the following items: () Obtain an IP address automatically
gl:lient for Microsaft Mebworks (%) Use the fallowing IP address:
gFile atd Pritter Sharing for Microsoft Hetworks IP address: Wm. 0.0 . 99
4311105 Packet Scheduler
3 Intemet Protocal [TCPAR) Subriet mask: 2550 .0 .0
Ingtall... Urinstal Properties
Diescription Obtain DMS server address automatically
Transmission Control Protocaol/Intemet Protocol. The default (®) Use the following DNS server addresses:
wide area nebwork protocol that provides communication
across diverse interconnected netwarks. Preferred DMS server:

Alernate DNS server: l:l

ok, Cancel [1]8 Cancel

Show ican in notification area when connected
Maotify me when this connection has limited or no connectivity
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It is sometimes necessary to reboot the computer to have the new address take effect.

If the UE2 unit was previously communicating with a computer with a different address,
then the UE2 unit must be reset (power off then on) for the unit to communicate to the new address.

With Windows XP there is an additional Authentication Tab. The Authentication must be
disabled to operate with the DAQIink unit.
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9.4 Windows 2000 Ethernet Setup

With Windows 2000 computer this can be done by the following procedure:

Right Click on My Network Places and select Properties.

Open

Explore

Search for Computers, .,

Wehio Am 1L,

Map Metwork Drive. ..
Disconneck Metwark Drive, ..

Create Shortcut
Renarme

Propetties

Right Click on an icon that corresponds to your network card and select Properties.
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Seismic

General |..-’-'u:|van|:eu:|-;

Connect uzing:

Thiz connection uzes the following i

E& Intel(R] 82567LM Gigabit Metwark Co

g Client for Microzoft Network
.Q File and Prirter Sharing for
Bl ()05 Packet Scheduler

S Internet Protocaol [TCRAP]

Irztall... Irinzt
[rezcription

Tranzmizzion Control Protocal/|nt
wide area network, protocal that g
across diverse interconnected ne

Show icon in notification area wh
M otify me when thiz connection i

Internet Protocol (TCP/IP) Properties

General |

the appropriate |F zettings.

{#1 Uze the following IP address:
IP address:

Subnet mazk:

Drefault gateway:

Obtain DMS server address a

Preferred DMS semver:

Alternate DMS server:

Y'ou can get [P zettings assigned automatically if vour network, supparts
thiz capability. Othensize, you need to azk your netwark, adminiztrator for

{3 Obtain an IF address automatically

L0 0.0

w0
[u}

|
EENETrEa
|

I

Ukarmatically

(%) Use the following DMS server addresses:

[ [].4 ][ Cancel ]

In this example, the current IP address “10.0.0.99”, and the Subnet Mask is “255.0.0.0”.

Select Internet Protocol (TCP/IP) and click on Properties button.

Use following IP address:
IP address 10.0.0.99
Subnet Mask  255.0.0.0

Press OK to accept entries.

It is sometimes necessary to reboot the computer to have the new address take effect.

If the UE2 unit was previously communicating with a computer with a different address,
then the UE2 unit must be reset (power off then on) for the unit to communicate to the new address.
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9.5 Firewall

It is important to disable all Firewalls on the computer. Third party firewall from Norton,
McAfee or other companies can completely disable the operation of the UE2 unit. Typically the
Firewall will allow the “ping” command to operate, but will block all other commands and
messages.

There is a built in Firewall with Windows XP. This should be disabled. Go to the
Advanced Menu of the Local Area Properties and disable the Firewall.

Typical Firewalls will ask if the program should be “blocked”, always select “Unblock this
program” if asked.

-i- Local Area Connection Properties

General | Adwanced

|ntemet Connection Firewwall

[ ] Pratect my computer and network. by lirmiting ar preventing
acceszs bo this computer fram the Internet

Learn mare about [nternet Connection Firevall.

Internet Connection Sharing

[ ] Allows other network. users to connect through this
computer's Intermet connection

Learn mare about Intermet Connection Sharing.

|f your're ot gure how to zet these properties, use

the Metwork, S etup 'wWizard instead.
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9.6 WinPcap

All Ethernet communication is actually done using the WinPcap driver.

This driver must be loaded correctly or none of the Ethernet message will work.
WinPcap Installation:

Only do the below instructions if WinPcap is not installed on the computer.
Download and install WinPcap to the computer following the link below:
http://www.winpcap.org/install/default.htm
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9.7 TCP/IP Address Verification

To verify that the IP address is correct, select “Start”, then “Run”, then type in “CMD”.
This starts the command prompt in Windows (This is similar to the old DOS command prompt).
Type the command “ipconfig”.

Command Prompt

Microsoft Windows HP [Uersion 5.1.260@1
(C» Copyright 1985-2081 Microsoft Corp.

C:wDocuments and Settings“AdministratorXipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix
IP Address. . . . . . . . . . 18.8.8.99
Subnet Mask . . . . . . . . . . 255.8.8.8
Default Gateway . . . . . . . .

C:“Documents and Settings*Administrator>_

In this example, the current IP address “10.0.0.99”, and the Subnet Mask is “255.0.0.0”.

Viewing the Network Tab at the bottom of the VScope program can also check the IP
address. The Network Tab shows the current IP address and Subnet Mask as detected by the
VScope program.

I3 2
Commenl] Hecordlnfo] Flot Infu] Status] Errors ] Commurication  Hetwork
Adapter Desc: Intel(R) 32567LM Gigabit Metwork Connection - Packet Scheduler Miniport A
IP &ddress: 10.0.0.93

IP tMask: 255.0.0.0
DHCF Enabled Mo

Il e 1

In this example, the current IP address “10.0.0.99”, and the Subnet Mask is “255.0.0.0”.
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10 Universal Encoder II Specifications

SPECIFICATIONS
GENERAL
Number of sweeps in library 64 standard, custom or linked
Sweep resolution 24-bit
Sample rate 0.25 msec
Vibrator Signature recording (HFVS™) Standard
Timing synchronization Set by GPS time or VHF radio message
Meshed Wireless Radio Available
External storage USB Flash
Built-in Ethernet speed 100 Mbit

SIZE AND POWER

Universal Encoder-lI

Size 325x242x66 mm (12.8x9.5x2.6")
Weight 3.6 kg (8 Ibs)

Power Input 9-36VDC

Force-lll

Size 406x2304x152 mm (16x12x6")
Weight 10 kg (22 Ibs)

Power Input 9-36VDC

SOFTWARE

Platform Windows XP, Windows 7 32-bit, 64-bit
Software Framework Microsoft .Net 4.0

I[e] Ethernet, USB, Serial

Supported Survey Input Standards SEG-P1, SPS

Supported Output Standards SPS, SEG-P1, SBS

Maximum number of Groups 256

Maximum number of Vibrators or Shooters 256

Maximum number of Simultaneous Sweeps 64

Supported Recording systems:
In Stand Alone mode:

- All GPS synchronized nodal recording systems, such as Sigma, Z-Land, GSR, Unite, etc.
- All GPS synchronized cable based continuous recording systems, such as 408/428 in microseismic mode

In Slave mode:
- RTl interface: OY O, ARAM
- OVC and SGD Interface: Sercel

Note: Specifications subject to change without notice.
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11 Schematics

11.1 UE2 Front Panel
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Seismic

AUX -1:

A - REF 1

B- ACOM
C-DIF REF1 +
D -DIF REF1 -
E-TB1+
F-TB1 -
G-TB1TTL
H-DCOM

AUX -2:

A - REF 1
B-ACOM

C - DIF REF2 +
D-DIF REF2-
E-TB2 +
F-TB2-
G-TB2TTL
H-DCOM

&

N

Seismic

Source

wwaseismicsource.com

Macke in the U.S.A.

\@l

o
AUX -3:
A- REF 3
B- ACOM
o | C-DIF REF3+
D - DIF REF3-
: E-TB3+
.« UNIVERSAL ENCODER IX el F-TEa-
2 3| c-TBITTL
- H - DCOM
TB1 TB2 TB3 TB4 AU -4
3| A-REFs
% B - ACOM
3 2| c-DIFREF4+
D - DIF REF4 -
REF1 REF2 REF3 REF4 DD
F-TB4-
% G-TB4TTL
g H - DCOM
E i
E |
g
B RADIO RADIO
REF  SIM
POWER/RADIO GPS RECORDER ﬁ
GPS (FEMALE 9-PIN): :
POWER/RADIO: i ) RECORDER:
1-STARTIN A
A- RADIO RET 2- DATA OUT 5_ DCOM
B - BAT + 3-DATA IN -MAINTB R
G- MIC ACT 3
0. NG 4- NG 4- REC START A
E- NG 5- GND 5 - DCOM
- 6- NG
6- DCOM
) 7-NG 8- TREF
G- SPKRACT 8. NG i
H-BAT- o 9- RADIO REF
i + 10 - RADIO SIM
11 - WL REF

12-+ 12V PULL-UP

13- REG START TTL A
14 - START INR
15-MAIN TB A

16 - DCOM

17 - REG START R
20 - DCOM

21- ACOM

22- ACOM

23- ACOM

24 - ACOM

25- +12V PULL UP
PINS - 7, 18, 19 N/C
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11.2 Connector wiring

Aux signals Voltage

True Reference is +/- 2.5 volts.

Time Break TTL is + 5 volts.

Time Break is + 200 millivolts

Differential True Reference is +/- 200 millivolts
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11.4 VSSS Output -TDMA

VSSS OUTPUT
MACC+ 8 Bm24Ga
MACC- Red24Ga p

GFORCE-+ Org24Ga_C
- Yell24 Ga D
BPACC- Gm24Ga_E
A ue 24 E

TRUE REF+ Vio2dGa G
TRUE REF- Gry24Ga H
T8 A Blue24Ga J
TB R Vio24Ga K

851-07C12-10P50
10-PIN MALE CON

Ya
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Seismic

11.5 TDMA to SGD Controller

18 IN
TOMA DECCDER
[, ] cLear AR D1 F zxe START SOURCE |
T o P e o ( 2PM18—7TK
— s = T = 1 2 7—S0OCKET FEMALE
A; (A) ()\4\ 1/4" SHRINK TUBE 1/4" EXPANDABLE SLEEVING
FCo RN L TO RS232
/ 0_0 O O \
[ D R VU | _| CcLEaR q RX 4 1 I
| © 0,00 oK| Lack N . N 2PM14—4TJ
Vo 8dao |/ e b B z | 4-PIN MALE
- 7| SHELD DCOM 1.
o o -
FGH N~
2D 1/2" SHRINK TUBE 1/4" EXPANDABLE SLEEVING
Y US
SOLDER SIDE TO USE
el TIME BREAK ACT (—‘ 5 S
- 2 —7TJ
TIME BREAK RET.
H T I 4 7—S0CKET MALE
LT3 1/47 EXPANDABLE SLEEVING
851-06AC14—-19F50 \
g—p CA ")
19—PIN MALE CABLE CONN 1/2" EXPANDABLE SLEEVING
BILL OF MATERIALS
4 ‘N ary ART # DESC.

: B51—-06AC14—19P50 1S—PIN MALE CABLE CONNECTOR
2PM14—4TJ 4=PI (ALE CABLE CONNECTOR
2PMIB-TTK 7—SOCKET FEMALE CABLE CONNECTCR
2PMIB-TJ 7-PI ALE CABLE CONNECTOR

1 2K_OHM_RESISTOR
T 200 OHW RESISTOR
e % i fowrce To. 1 10K _OHM RESISTOR
L Y 2535 E. Coenan k.
el Barca City, o 74604 ] 15K_OHN_RESISTOR
ry _— wselsmicsource.com 1 0.1 uF CAPACITOR
i . e 8 FT 8541 2-COND. 26 AWG GRAY CABLE
PRV [oppg ECOER T8 SAD CONTROLLER 6 FT BEGP—0500-0 7/2" EXPANDABLE SLEEVING
T s 41/2 FT BEGP—250—0—BLK 1/4" EXPANDABLE SLEEVING
i B ‘ F:dTHMéiZwH—L § N | A-FIT—2218—1/4—4—0-BLACK /4" SHRINK TUBE
T [ fecr s or s TN A—FT—2218—5/32—4-0 3/52° SHRINK TUBE
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11.6 RTM UE2 AWD interface

Recording Trailer
AWD & PEG

Computer
20 ms Delay to TB

Source Link/Sigma Observer

B
20 ms Total Delay
WR/Rad  GPS Redr
Radio ‘ UEZ - 10 ms Delay
Hot Remote Start

Used

I

Power Supply
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MINI FUSE HOLDER F1057-NDCXHMIND
S-AMP MINL FUSE - 0297005.WXNV(XSAMINI-1)

RED rgv LARGE_ALLIGATOR CLIP - B60-4341CCONNLALLCLY
LARGE RED BONT - B6(-4455(CONNLALLBTRED)
13 | RED
BLK GND LARGE ALLIGATOR CLIP - 860-4341CCONNLALLCLY
3 9 LARGE BLACK BODT - 860-4460CCONNLALLBTBLK)
SHLD
couruTeR
= D A SWD [T s
CLR I\ TX COMPUTER [T
e T i) :
3 BLK RX _COMPUTER \ BLK 3 9
A 5-SOCKET FEMALE DSUB-DERSTS (COMMOSFDBCT)
8641 - W24GRAYORSHLD BAGKEHELL 40-4700H{COMNPBS0899)
et
- i
o | RED RED [T
o | BLk BK |1
e —
e A e N P
rer e - e e A R SR
w0
20| BED MIC ACT — ReD [
BLK RAD RET ] BLEK
15 L] 8 c o
10| wr PTT acT - wr | o o
16 | GRN SPKR_ACT Y= N | p 1o o
BLK SPKR RET 1l Q BLE
17} L ol £ SOLDER SkE BILL_OF NATERIALS
5~ SOCKET FEMALE — MSIIOBEO1 45055 [ar 5
CONNOSFCRCTI 657 7 T comowmeer ¥ SOEKET FOMALE D508
[z | comasracs 5 SOCHET FEMALE 0SUS
COWPBSDB09 | U PR/SOCKET FLASTIC BACKHELL
[z | cowrssoszs 25 PIN/SOCKET FLASTIC BACKSHELL
2T comare LARGE ALLGATOR CLPS
—— LLBTaLX | [ARGE ALLIGATGR CUP BOOT BLAGK
ovsaesefosseu 3391 E. Covenan R, NDTES: ]
PR A cokricsorcecon| 1 ALL WIRES 5 FT LONG UNLESS OTHERWISE NOTED
e 2 DUTPUT 1 - CLOSED, UE2 INTERNAL JUMPER CONMNECTED :
e TH ENCODER TO UE 2 1
- T WE NI REY =
B | RTMEUER-1 2] wowis 174" EXPANDABLE SLEEVNG
i Toer 1 oy W | wexweEs. 57 | 5/5 BLAGK HeAT SNk
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pylai I act N RED[ L
PYE T RAD RET 0 s e
Py ")
o WHT FTT ACT WHT of
o oH D 3 &
B | RN SPKR_ACT GRN| g
o co o
= _GRN - i)
5-SOCKET FEMALE — us3ioeerss—ss | p | Bk N SPKR RET Bk | ¢ S-PIN MALE — MS3I01AI4S-5P
CONNOSFORCTI 45R COMMOSMCRCTI4
BLK
SPKR_ACT GRH ot
. Y
SPKR RET 04
ce o
S-PIN MALE — MS31DIAT4S-5P
COMNOSMCRCTi4
BILL OF MATERIALS
EsTIERG beas/zu S350 £. Coteran 0t arr PART § DESC
HEERT Ponca CF 74604 1 CONNOSFCRCTI 45R 5—SOCKET FEMALE CABLE CONNECTOR
— ——— CONNOSMCRCTI4 5-PIN MALE CABLE CONNECTOR
v 1 FT | W24GRAYOBSHLD G-CONDUCTOR_GRAY CABLE W/ SHIELD
oVED E2 - RTM RADID Y CABLE 7T W24AWGBLK BLAGK 24 AVIG WIRE
- - — - 1T W24AWGGRN 24 AWG GREEN WIRE
i B K/usakmwnm 2T WEXP1_4 174" EXPANDABLE_SLEEVING
| iver 1 o 1 3N WSKTUBE3_32 3/32°_SHRINK_TUBE
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WIB to PEG

H
WTB H
Microphone

7

computer

0

Hammer Switch on PEG

AWD GPE

RTH

D DD Wall Mosan D D Computer E

S3C owned Equipment
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12 Appendix

12.1 Appendix A — COG File Format

Navigation File (.NAYV file) Format:

Column 1: ShotPoint Line and ShotPointStation number combined
Column 2: ShotDate

Column 3: ShotTime

Column 4: Latitude in decimal degrees

Column 5: Longitude in decimal degrees
Column 6: Elevation

Column 7: Root Mean Square of HDOP
Column 8: Standard Deviation of the Latitude
Column 9: Standard Deviation of the Longitude
Column 10: Standard Deviation of the Elevation

If using the Average values option:

Column 11: Mean Averageof HDOP
Column 12: Mean Averageof PDOP
Column 13: Mean Averageof VDOP
Column 14: Mean Averageof Satellites
Column 15: Mean Averageof GPS Quality
Column 16: Mean Averageof Correction Age

If using the worst case option:

Column 11: WorstCase value of HDOP

Column 12: WorstCase value of PDOP

Column 13: WorstCase value of VDOP

Column 14: WorstCase value of Number of Satellites
Column 15: WorstCase value of GPS Quality
Column 16: WorstCase value of CorrectionAge

Column 17: Number of ignored positions

Example line:

50811046,10/08/2010,07:44:37.1, 37.70973458, 40.60930424,  747.2, 0.6400,0.0000000000293403, 0.0000000002147039, 0.03, 08, 0.0, 00, 10, 15 0
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NAV_RAW File:

Column 1:
Column 2:
Column 3:
Column 4:
Column 5:
Column 6:
Column 7:
Column 8:
Column 9:

Column 10:
Column 11:
Column 12:
Column 13:
Column 14:
Column 15:
Column 16:
Column 17:
Column 18:

ShotPoint Line and ShotPointStation number combined
Energy Point Index or Sweep Index (in other words)
Vibrator ID

ShotDate

ShotTime

Latitude in decimal degrees

Longitude in decimal degrees

Elevation

Not Used, always 0

Not Used, always 0

Not Used, always 0

Not Used, always 0

HDOP

PDOP

VDOP

Satellites

Quality

Correction Age

Example line:

50891033,01,01,10/08/2010,07:04:43.2, 37.71343333, 40.60245333,  749.76,

1.2,0,0,0 0.0, 00, 9, 5, 100

NAV_FILTERED File:

Column 1:
Column 2:
Column 3:
Column 4:
Column 5:
Column 6:
Column 7:
Column 8:
Column 9:
Column 10
Column 11

ShotPoint Line and ShotPointStation number combined
Energy Point Index or Sweep Index (in other words)
Vibrator ID

ShotDate

ShotTime

Latitude in decimal degrees

Longitude in decimal degrees

Elevation

Not Used, always 0

: Not Used, always 0
:Not Used, always 0
Column 12:
Column 13:
Column 14:
Column 15:
Column 16:
Column 17:
Column 18:

Not Used, always 0
HDOP

PDOP

VDOP

Satellites

Quality

Correction Age

Example line:

50891033,01,01,10/08/2010,07:04:43.2, 37.71343333, 40.60245333,  749.76,

1.2,0,0,0 0.0, 00, 9, 5, 100
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12.2 Appendix B — SBS File Format

SBS File Format:
shotpoint<T>epoch time<T>ascii time<T>ascii date<T>easting [status]<T>northing
[status]<T>depth [status]<T>line name<CR>

where<T> is a tab character. The file is in DOS format (just a CR at end of end line).

Example line:
1000.0 1267734651.96800000 20:30:51.975078 03/04/2010 0.0 [OK] 0.0 [OK] 0.0 [OK] 100.0
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12.3 Appendix C — SEG-P1 Format

Record ID cols 01-01 (character)

The character "H" in this position indicates a header record. The position is blank for all
other records and ignored by most loaders.

Line Name/Number cols 02 - 17 (character)

The seismic line name or number is a 16 character alpha-numeric identifier. Spaces are
acceptable but often cause trouble in some application software.

Shot Point Number  cols 18 - 25 (integer)

The shot point or station number is an integer variable. This field must contain a non-blank
number from one to 8 digits in length. Negative numbers are acceptable, but some loaders cannot
handle them.

Reshoot code cols 26 - 26 (character)

The reshoot code is a single character (A,B,C etc) most commonly used to indicate a second
or third shot at the same shot point number. It is used less frequently in contemporary data
acquisition and only seldom used for marine data.

Latitude degrees cols 27 - 28 (integer)

The value of latitude in degrees for the seismic station (may vary from O to 90 degrees
north or south of the equator)

Latitude minutes cols 29 - 30 (integer)

The portion of the latitude coordinate in minutes of arc (may vary from O to 60). Note that
this field may be zero or contain blanks, as may any other integer field in this format.

Latitude seconds cols 31 - 34 (integer)

The portion of latitude in seconds of arc. This is a 4 digit field and is commonly written
with an implied decimal between the first two and the second two digits, which represents the value
of seconds to the nearest 100th of a second. The format specification does allow a decimal in the
field, but this is seldom used since it reduces precision. (may vary from 0 to 6000 which represents
a value of 0 to 60.00 seconds).

Hemisphere N/S cols 35 - 35 (character)

A single character designating the northern (positive) or southern (negative) hemisphere.

Longitude degrees cols 36 - 38 (integer)

The value of longitude in degrees for the seismic station (may vary from O to 180 degrees
east or west of Greenwich). Note that this is a three digit field as compared to the 2 digit field for
latitude.

Longitude minutes cols 39 -40 (integer)

The portion of the longitude coordinate in minutes of arc (may vary from O to 60).

Longitude seconds cols 41 -44 (integer)

The portion of longitude in seconds of arc. This is a 4 digit field and is commonly
written with an implied decimal as noted above to represent the value of seconds to the nearest
100th of a second.

Hemisphere E/W cols 45 - 45 (character)

A single character designating the eastern (positive) or western (negative) hemisphere

X coordinate cols 46 - 53 (integer)

The X coordinate of the station based on the local Cartesian coordinate system. This value
may be in feet or meters, and may be positive or negative. Note that SEGP1 has no provision for
defining the local coordinate system or its transformation to lat/long coordinates. These details
should appear in the header if required.
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Y coordinate cols 54 - 61 (integer)

The Y coordinate of the station based on the local coordinate system. This value may also
be positive or negative, but must be in the same units and same coordinate system as the X
coordinate. (Note that an F8.1 floating point value is also legal, but seldom used, in this and the
previous field).

Station Elevation cols 62 - 66 (integer)

The station elevation in feet or meters above (or below) datum. Datum is usually sea level
unless otherwise specified in the header. Note that this field is often used for water depth in marine
shooting. (An F5.1 floating point field is also legal).

Misc Items cols 67 -80 (integers)

There are five additional numeric fields defined in the format for use in specifying
time, date and other items related to field operations. They are seldom used in data exchange files
and the fields usually appear as blanks or zeros. For details on these items see the above SEG
reference.

Example line:

500109 35270646N099402058W15018889 168
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